# User’s Guide

## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction</strong></td>
<td></td>
</tr>
<tr>
<td>Qualified Persons</td>
<td>3</td>
</tr>
<tr>
<td>Read this Instruction Sheet</td>
<td>3</td>
</tr>
<tr>
<td>Retain this Instruction Sheet</td>
<td>3</td>
</tr>
<tr>
<td>Proper Application</td>
<td>3</td>
</tr>
<tr>
<td>Warranty</td>
<td>4</td>
</tr>
<tr>
<td>End User License Agreement</td>
<td>4</td>
</tr>
<tr>
<td><strong>Safety Information</strong></td>
<td></td>
</tr>
<tr>
<td>Understanding Safety-Alert Messages</td>
<td>5</td>
</tr>
<tr>
<td>Following Safety Instructions</td>
<td>5</td>
</tr>
<tr>
<td>Replacement Instructions and Labels</td>
<td>5</td>
</tr>
<tr>
<td><strong>Software Installation</strong></td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>6</td>
</tr>
<tr>
<td>Software Compatibility</td>
<td>6</td>
</tr>
<tr>
<td>Computer and Program Requirements</td>
<td>7</td>
</tr>
<tr>
<td>Software Installation</td>
<td>7</td>
</tr>
<tr>
<td>License Management</td>
<td>8</td>
</tr>
<tr>
<td>Trial Registration</td>
<td>10</td>
</tr>
<tr>
<td>Computer MAC Address</td>
<td>11</td>
</tr>
<tr>
<td>License Activation File</td>
<td>12</td>
</tr>
<tr>
<td>Online Activation Options</td>
<td>16</td>
</tr>
<tr>
<td><strong>Tools and Features</strong></td>
<td></td>
</tr>
<tr>
<td>Start Page</td>
<td>17</td>
</tr>
<tr>
<td>Recent Option</td>
<td>19</td>
</tr>
<tr>
<td>Drawing Workflow</td>
<td>20</td>
</tr>
<tr>
<td>Workspace</td>
<td>21</td>
</tr>
<tr>
<td>Miscellaneous Tools</td>
<td>21</td>
</tr>
<tr>
<td>Drawing Tools</td>
<td>22</td>
</tr>
<tr>
<td>File Menu</td>
<td>30</td>
</tr>
<tr>
<td>System Menu</td>
<td>31</td>
</tr>
<tr>
<td>Circuit Menu</td>
<td>32</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>32</td>
</tr>
<tr>
<td>Group Tools</td>
<td>33</td>
</tr>
<tr>
<td>Options Menu</td>
<td>33</td>
</tr>
<tr>
<td>Pinned Dialog Boxes</td>
<td>37</td>
</tr>
<tr>
<td>Configuration Display</td>
<td>40</td>
</tr>
<tr>
<td>Validation Errors and Warnings</td>
<td>40</td>
</tr>
<tr>
<td><strong>System Design Tutorial</strong></td>
<td></td>
</tr>
<tr>
<td>Sources</td>
<td>56</td>
</tr>
<tr>
<td>Wire Connection Points</td>
<td>58</td>
</tr>
<tr>
<td>Adding Wires</td>
<td>60</td>
</tr>
<tr>
<td>Adding Switches</td>
<td>65</td>
</tr>
<tr>
<td>Setting the Normal State</td>
<td>67</td>
</tr>
<tr>
<td>Validating</td>
<td>68</td>
</tr>
<tr>
<td>Fragmented Circuit</td>
<td>69</td>
</tr>
<tr>
<td>Trace Connections</td>
<td>69</td>
</tr>
<tr>
<td>RTU Address and Serial Numbers</td>
<td>70</td>
</tr>
<tr>
<td>Updating Attributes</td>
<td>70</td>
</tr>
<tr>
<td>Team Designations</td>
<td>76</td>
</tr>
<tr>
<td>Device Attributes</td>
<td>77</td>
</tr>
<tr>
<td><strong>System Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>81</td>
</tr>
<tr>
<td>Updating IntelliTeam SG Software</td>
<td>81</td>
</tr>
<tr>
<td>Configuring Field Devices</td>
<td>82</td>
</tr>
<tr>
<td>Communications Manager</td>
<td>82</td>
</tr>
<tr>
<td>Communications Tools</td>
<td>83</td>
</tr>
<tr>
<td>Dialog Box Tab</td>
<td>85</td>
</tr>
<tr>
<td>Entry Point Device Configuration Tab</td>
<td>86</td>
</tr>
<tr>
<td>Options</td>
<td>87</td>
</tr>
<tr>
<td>Device Configuration Tab</td>
<td>88</td>
</tr>
<tr>
<td>Operational Log Tab</td>
<td>90</td>
</tr>
<tr>
<td>FeederNet Status Tab</td>
<td>91</td>
</tr>
<tr>
<td>Propagation</td>
<td>91</td>
</tr>
<tr>
<td>Testing Communications and Retrieving Device</td>
<td>93</td>
</tr>
<tr>
<td>FeederNet Data</td>
<td>93</td>
</tr>
</tbody>
</table>
Table of Contents—Continued

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instant Replay</td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>100</td>
</tr>
<tr>
<td>Collecting Data</td>
<td>101</td>
</tr>
<tr>
<td>Connection Setup</td>
<td>102</td>
</tr>
<tr>
<td>Connection Setup for Data Collection</td>
<td>103</td>
</tr>
<tr>
<td>Setting Common Communication Parameters</td>
<td>105</td>
</tr>
<tr>
<td>Connection Check for Data Collection</td>
<td>106</td>
</tr>
<tr>
<td>Retrieval Settings</td>
<td>106</td>
</tr>
<tr>
<td>Timestamps</td>
<td>107</td>
</tr>
<tr>
<td>Opening Instant Replay File</td>
<td>107</td>
</tr>
<tr>
<td>Playback Controls</td>
<td>108</td>
</tr>
<tr>
<td>Event Playback</td>
<td>109</td>
</tr>
<tr>
<td>Subsequence</td>
<td>110</td>
</tr>
<tr>
<td>HTML Output</td>
<td>111</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instant Replay from Compact Flash Files</td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>112</td>
</tr>
<tr>
<td>Using Compact Flash Files</td>
<td>112</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Viewer</td>
<td></td>
</tr>
<tr>
<td>Log Viewer Overview</td>
<td>120</td>
</tr>
<tr>
<td>Log Viewer File Menu</td>
<td>121</td>
</tr>
<tr>
<td>Database Connection</td>
<td>121</td>
</tr>
<tr>
<td>Tailing a Log</td>
<td>122</td>
</tr>
<tr>
<td>Logging Files</td>
<td>123</td>
</tr>
<tr>
<td>Filters</td>
<td>123</td>
</tr>
<tr>
<td>Exporting Data</td>
<td>126</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exporting IntelliTeam Designer Data</td>
<td></td>
</tr>
<tr>
<td>Exporting Data</td>
<td>127</td>
</tr>
<tr>
<td>FMS Export Features</td>
<td>129</td>
</tr>
</tbody>
</table>
Qualified Persons

**WARNING**

Only qualified persons who are knowledgeable in the installation, operation, and maintenance of overhead and underground electric distribution equipment, along with all associated hazards, may install, operate, and maintain the equipment covered by this publication. A qualified person is someone who is trained and competent in:

- The skills and techniques necessary to distinguish exposed live parts from nonlive parts of electrical equipment
- The skills and techniques necessary to determine the proper approach distances corresponding to the voltages to which the qualified person will be exposed
- The proper use of special precautionary techniques, personal protective equipment, insulated and shielding materials, and insulated tools for working on or near exposed energized parts of electrical equipment

These instructions are intended ONLY for such qualified persons. They are not intended to be a substitute for adequate training and experience in safety procedures for this type of equipment.

Read this Instruction Sheet

**NOTICE**

Thoroughly and carefully read this instruction sheet and all materials included in the product's instruction handbook before installing or operating an IntelliTeam SG Automatic Restoration System. Familiarize yourself with the Safety Information on page 5. The latest version of this publication is available online in PDF format at sandc.com/en/contact-us/product-literature/.

Retain this Instruction Sheet

This instruction sheet is a permanent part of your IntelliTeam SG Automatic Restoration System. Designate a location where you can easily retrieve and refer to this publication.

Proper Application

**WARNING**

The equipment in this publication is only intended for a specific application. The application must be within the ratings furnished for the equipment.
Introduction

Warranty

The warranty and/or obligations described in S&C’s Price Sheet 150, “Standard Conditions of Sale–Immediate Purchasers in the United States,” (or Price Sheet 153, “Standard Conditions of Sale–Immediate Purchasers Outside the United States,”) plus any special warranty provisions, as set forth in the applicable product-line specification bulletin, are exclusive. The remedies provided in the former for breach of these warranties shall constitute the immediate purchaser’s or end user’s exclusive remedy and a fulfillment of the seller’s entire liability. In no event shall the seller’s liability to the immediate purchaser or end user exceed the price of the specific product that gives rise to the immediate purchaser’s or end user’s claim. All other warranties, whether express or implied or arising by operation of law, course of dealing, usage of trade or otherwise, are excluded. The only warranties are those stated in Price Sheet 150 (or Price Sheet 153), and THERE ARE NO EXPRESS OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. ANY EXPRESS WARRANTY OR OTHER OBLIGATION PROVIDED IN PRICE SHEET 150 (OR PRICE SHEET 153) IS GRANTED ONLY TO THE IMMEDIATE PURCHASER AND END USER, AS DEFINED THEREIN. OTHER THAN AN END USER, NO REMOTE PURCHASER MAY RELY ON ANY AFFIRMATION OF FACT OR PROMISE THAT RELATES TO THE GOODS DESCRIBED HEREIN, ANY DESCRIPTION THAT RELATES TO THE GOODS, OR ANY REMEDIAL PROMISE INCLUDED IN PRICE SHEET 150 (or PRICE SHEET 153).

End User License Agreement

The end user is granted a nontransferable, non-sublicensable, nonexclusive license to use the IntelliTeam Designer software, IntelliLink Setup Software, IntelliTeam SG Automatic Restoration software, and/or other software furnished with the IntelliTeam SG Automatic Restoration System only upon acceptance of all the terms and conditions of the seller’s end-user license agreement set forth in Price Sheet 155.
Several types of safety-alert messages may appear throughout this instruction sheet. Familiarize yourself with these types of messages and the importance of these various signal words:

### DANGER

“DANGER” identifies the most serious and immediate hazards that will result in serious personal injury or death if instructions, including recommended precautions, are not followed.

### WARNING

“WARNING” identifies hazards or unsafe practices that can result in serious personal injury or death if instructions, including recommended precautions, are not followed.

### CAUTION

“CAUTION” identifies hazards or unsafe practices that can result in minor personal injury if instructions, including recommended precautions, are not followed.

### NOTICE

“NOTICE” identifies important procedures or requirements that can result in product or property damage if instructions are not followed.

---

**Understanding Safety-Alert Messages**

**Following Safety Instructions**

If you do not understand any portion of this instruction sheet and need assistance, contact the nearest S&C Sales Office or S&C Authorized Distributor. Their telephone numbers are listed on S&C’s website [sandc.com](http://sandc.com), or call S&C Headquarters at (773) 338-1000; in Canada, call S&C Electric Canada Ltd. at (416) 249-9171.

**Replacement Instructions and Labels**

If you need additional copies of this instruction sheet, contact the nearest S&C Sales Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be replaced immediately. Replacement labels are available by contacting the nearest S&C Sales Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.
Overview

S&C’s IntelliTeam Designer software has an easy, intuitive user interface for configuring the IntelliTeam SG Automatic Restoration System. The drawing environment uses a familiar set of drawing tools for developing the circuit that are similar to other Dialog boxes-based drawing programs.

Simply draw the distribution system, configure attributes such as load constraints and RTU addresses, and use the Validate tool to complete the configuration process. When the circuit has been validated, connect IntelliTeam Designer to one of the team members, and IntelliTeam Designer configures the system.

Software Compatibility

Table 1 shows the S&C IntelliTeam Designer software revision required for use with various S&C device software revisions.

<table>
<thead>
<tr>
<th>IT Designer Release Date</th>
<th>IT Designer Revision</th>
<th>IntelliRupter R2 Control Installer</th>
<th>IntelliRupter R3 Control Installer</th>
<th>IntelliNode Installer</th>
<th>68xx Series Installer</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/23/2010</td>
<td>1.0.0.5●</td>
<td>2.3.3</td>
<td>N/A</td>
<td>1.6.8</td>
<td>N/A</td>
</tr>
<tr>
<td>8/1/2011</td>
<td>2.1.x.x■</td>
<td>3.2.9</td>
<td>N/A</td>
<td>1.7.6</td>
<td>3.2.x</td>
</tr>
<tr>
<td>3/1/2012</td>
<td>3.0.x.x or 3.1.x.x■</td>
<td>3.3.x</td>
<td>N/A</td>
<td>3.3.x</td>
<td>3.3.x</td>
</tr>
<tr>
<td>3/8/2012</td>
<td>3.0.x.x or 3.1.x.x■</td>
<td>3.4.x.x■</td>
<td>N/A</td>
<td>3.4.x.x</td>
<td>3.4.x.x</td>
</tr>
<tr>
<td>3/11/2013</td>
<td>4.0.x.x■</td>
<td>3.5.x.x■</td>
<td>N/A</td>
<td>3.5.x.x</td>
<td>3.5.x.x</td>
</tr>
<tr>
<td>11/11/2013</td>
<td>5.0.x.x■</td>
<td>3.6.x.x■</td>
<td>N/A</td>
<td>3.6.x.x</td>
<td>3.6.x.x</td>
</tr>
<tr>
<td>4/2/2015</td>
<td>6.0.42.0■</td>
<td>6.1.x.x■</td>
<td>N/A</td>
<td>6.1.x.x</td>
<td>6.1.x.x</td>
</tr>
<tr>
<td>7/8/2016</td>
<td>6.0.43.17■</td>
<td>6.1.x.x or 6.3.x.x■</td>
<td>N/A</td>
<td>6.1.x.x or 6.3.x.x</td>
<td>6.1.x.x or 6.3.x.x</td>
</tr>
<tr>
<td>7/31/2017</td>
<td>7.1.x.x■</td>
<td>6.1.x.x or 6.3.x.x or 7.1.x.x■</td>
<td>N/A</td>
<td>6.1.x.x or 6.3.x.x or 7.1.x.x■</td>
<td>6.1.x.x or 6.3.x.x or 7.1.x.x■</td>
</tr>
<tr>
<td>9/21/2020</td>
<td>7.3.x.107▲</td>
<td>6.1.x.x or 6.3.x.x or 7.1.x.x or 7.3.x.x■</td>
<td>7.3.x.x■</td>
<td>6.1.x.x or 6.3.x.x or 7.1.x.x or 7.3.x.x■</td>
<td>6.1.x.x or 6.3.x.x or 7.1.x.x or 7.3.x.x■</td>
</tr>
<tr>
<td>8/31/2021</td>
<td>7.5.x.x▲</td>
<td>6.1.x.x or 6.3.x.x or 7.1.x.x or 7.3.x.x■</td>
<td>7.3.x.x▲</td>
<td>6.1.x.x or 6.3.x.x or 7.1.x.x or 7.3.x.x■</td>
<td>6.1.x.x or 6.3.x.x or 7.1.x.x or 7.3.x.x■</td>
</tr>
</tbody>
</table>

● IntelliTeam Designer software is included in the product installer and is activated with a license key.
■ IntelliTeam Designer revision 2.1.x.x and later installers are available for download at the S&C Automation Customer Support Portal in the IntelliTeam SG system workspace. They require installation of a customer activation file, which must contain the registered MAC address of the computer using the IntelliTeam Designer program. To use IntelliTeam Designer 3.1.x.x or later, all field device revisions must be the latest revision.
▲ IntelliTeam Designer 7.3.x.x or later only requires the registration of a single MAC address to use the application.
**NOTICE**

A remote or local firmware upgrade puts a control into the **Prohibit Restoration** state. When upgrading controls in an IntelliTeam SG system, use the following procedure:

**STEP 1.** Upgrade the control software. This can be done with IntelliLink® Setup Software.

**STEP 2.** After the upgrade, verify that all settings were preserved.

**STEP 3.** Use the IntelliTeam Designer version compatible with the control software version to repush IntelliTeam SG system configuration to all FeederNets that have updated devices.

**STEP 4.** If a device is an open point, push the configuration to both FeederNets for that device.

**STEP 5.** Verify the team configurations.

**STEP 6.** For IntelliNode™ Interface Modules only, set the **External Device Data Updated** setpoint to the **Running** mode.

**STEP 7.** Enable the **Automatic Restoration** mode on all upgraded controls.

---

**Computer and Program Requirements**

To install IntelliTeam Designer software on the computer, these are needed:

- A portable personal computer with Microsoft® Windows® 7, an Intel® Core™ i7 processor with 8 GB of RAM (recommended), or a dual-core processor with 4 GB of RAM (minimum), an onboard Ethernet card, an onboard wireless card (including USB), an Internet browser, and access to **sandc.com** (Windows® 10 is also supported but Windows XP is not supported.)

- Administrative privileges

**Software Installation**

The IntelliTeam Designer software installer is available for download at the S&C Automation Customer Support Portal in the IntelliTeam SG Software workspace. A password is required to access the portal, and the password can be requested on the login page. Go to **http://sandc.com/en/contact-us/sc-customer-portal/**. See Figure 1 on page 8.

---

**NOTICE**

Administrator Privilege must be used to run the IntelliTeam Designer Setup installer in the Windows 7 64-Bit or Windows 10 operating systems.

Download and run the IntelliTeam Designer Setup installer.
Software Installation

The IntelliTeam SG Automatic Restoration System has two basic software components: IntelliTeam Designer configuration and license management software and the IntelliTeam SG feature license. They are licensed separately. The IntelliTeam SG feature license has bronze and gold levels. S&C Specification Bulletin 1044-31 lists the features included in the license level. Every device controlled by IntelliTeam SG software includes a bronze-level license. The gold level is sold separately and must be assigned to a specific device. IntelliTeam Designer is provided separately and requires an IntelliTeam Designer slot for each device. Every device must be associated with a specific designer slot before it can be used in an IntelliTeam SG system. IntelliTeam Designer can be installed on any number of computers. S&C Specification Bulletin 1044-31 describes the IntelliTeam Designer licensing requirements.

Follow these steps to assign the designer slots and feature licenses to specific assets (devices):

**STEP 1.** Log in to the S&C Automation Customer Support Portal at sandc.com. If the user doesn’t have an account, submit a password request at the Login screen.

**STEP 2.** Select the Licensing tab to view the device assets and the available licenses.

**STEP 3.** When the necessary licenses for the devices have been obtained, contact sandc.com/en/contact-us/technical-support/ with “Asset Assignment Report” in the subject field, and include the name of the company that owns the IntelliTeam SG system licenses in the body of the email. The reply from S&C will list all the company’s IntelliTeam SG system assets. A sample asset file is shown in Figure 2 on page 9.

License Management

The IntelliTeam SG Automatic Restoration System has two basic software components: IntelliTeam Designer configuration and license management software and the IntelliTeam SG feature license. They are licensed separately. The IntelliTeam SG feature license has bronze and gold levels. S&C Specification Bulletin 1044-31 lists the features included in the license level. Every device controlled by IntelliTeam SG software includes a bronze-level license. The gold level is sold separately and must be assigned to a specific device. IntelliTeam Designer is provided separately and requires an IntelliTeam Designer slot for each device. Every device must be associated with a specific designer slot before it can be used in an IntelliTeam SG system. IntelliTeam Designer can be installed on any number of computers. S&C Specification Bulletin 1044-31 describes the IntelliTeam Designer licensing requirements.

Follow these steps to assign the designer slots and feature licenses to specific assets (devices):

**STEP 1.** Log in to the S&C Automation Customer Support Portal at sandc.com. If the user doesn’t have an account, submit a password request at the Login screen.

**STEP 2.** Select the Licensing tab to view the device assets and the available licenses.

**STEP 3.** When the necessary licenses for the devices have been obtained, contact sandc.com/en/contact-us/technical-support/ with “Asset Assignment Report” in the subject field, and include the name of the company that owns the IntelliTeam SG system licenses in the body of the email. The reply from S&C will list all the company’s IntelliTeam SG system assets. A sample asset file is shown in Figure 2 on page 9.
Figure 2. Sample asset file.

Follow these steps to update the activation file:

**STEP 1.** *For version 7.3.x.x and later:* open the asset file and enter the required asset associations. All assets when entered in the license database are automatically assigned a bronze-level license and a designer slot assignment of 0. To upgrade an asset, change the license type to gold as needed. To assign a designer slot to an asset, change the 0 to 1. A designer slot assignment of 1 is required for IntelliTeam Designer to recognize the asset for use in an IntelliTeam SG system.

*For versions 7.1.x.x or earlier:* register the computers that will use IntelliTeam Designer software. Register the computer MAC address. See the “Computer MAC Address” section on page 8 for the procedure to determine the MAC address of the computer. Include the MAC address of the computer in the same email sent to return the updated asset file. Also include the name of the company that owns the IntelliTeam SG system licenses, the name of the primary computer user, and the computer user’s email address and phone number. To determine whether the computer has already been registered, select the Licensing tab to view a list of the authorized users registered to the account.

**Note:** IntelliTeam Designer 7.3.x.x and later no longer requires registering the computer MAC address as long as there is a single MAC address registered as part of the activation file.

**NOTICE**

The IntelliTeam Designer license includes an IntelliLink Setup Software license by default. There is no need to request registration of the computer for the setup software.

**STEP 2.** Download and save the license activation file: ActivationFile.xml, as directed in the “License Activation File” section on page 12. An email notification that the activation file is ready will be sent. Then, log in to the S&C Automation Customer Support Portal account and save the Activation File. When IntelliTeam Designer is installed and the license activation file saved, the IntelliTeam SG system can be configured.
An IntelliTeam Designer trial registration does not have the full-license capability to propagate a netlist or collect event data for replay. **Trial** mode provides a library of pseudo serial numbers and licenses that allow building and validating IntelliTeam SG system configurations for training purposes.

**Trial** mode is ideal for training and software evaluation, and it does not require activation file registration. Circuit diagram configurations created with **Trial** mode can be repopulated with the serial numbers of registered products at a later date. To use IntelliTeam Designer **Trial** mode, click on the **OK** button in the license notification dialog box and click on the **Yes** button in the IntelliTeam Designer (Trial) dialog box. See Figures 3 and 4.

![Figure 3. Startup licensing dialog box.](image)

![Figure 4. IntelliTeam Designer (Trial) confirmation dialog box.](image)
In the IntelliTeam Designer Start page, click on the **Activate** button on the left side. On the right side, click on the **Offline Activation** button to load the **Offline Activation** screen at the right, if not already shown. The MAC address is located above the **Offline Activation** button, or it can be found below the “License Information” section. See Figure 5.

**Figure 5.** IntelliTeam Designer Start page, location of MAC address.

The S&C CheckMacAddress.exe utility can also be obtained at the IntelliTeam SG Software workspace on the S&C Automation Customer Support Portal. See Figure 6. Save this utility on the computer desktop, and double click to run the utility. The computer MAC address required for registration will be reported by this utility.

**Figure 6.** IntelliTeam SG Software workspace on the S&C Automation Customer Support Portal.
It is not common, but sometimes a computer does not have an Ethernet adapter local area connection. In that case, register the wireless MAC address. If running the program CheckMacAddress.exe, it will report the wireless MAC address for that computer.

Registration also allows use of the USB MAC address. CheckMacAddress.exe reports in this order: (1) Ethernet adapter local area connection, (2) Wireless MAC address, and (3) USB MAC address.

License Activation File

Go to sandc.com, click on the Support tab, and then click on the S&C Automation Customer Support Portal entry in the left column. Enter the username and password to login.

Select the Licensing tab and verify there is a valid license association and the correct MAC address for the computer. Select the Activation File tab. This generates a new activation file with the present information displayed at the Licensing tab. Then, a File Download dialog box will open. Click on the Save button and a Save As dialog box will open. Save the ActivationFile.xml on the desktop.

Note: The IntelliTeam Designer program now notifies users when the activation file is about to expire. This notification is displayed 30 days before the activation file expires and then every five days thereafter until either the activation file is updated or expires. When the activation file expires, a new notification will be displayed telling the user the activation file is now expired and needs to be updated.

Offline Activation with IntelliTeam Designer

Use the Offline Activation process to automatically place the activation file in the correct directory on the computer. To do so, follow these steps:

STEP 1. In the Start page of IntelliTeam Designer, click on the Activate button on the left. If IntelliTeam Designer is already open, access the Start page by clicking on the File tab in the top menu and then selecting the Close option.

STEP 2. Click on the Offline Activation button to load the Activate Offline screen shown on the right in Figure 7 on page 13.

STEP 3. Click on the Offline Activation button on the right.

STEP 4. Navigate to the desktop and select the ActivationFile.xml entry to activate IntelliTeam Designer. IntelliTeam Designer will restart after the ActivationFile.xml data have been successfully loaded. See Figure 7 on page 13.
Offline Activation

The activation file can also be manually saved in the following locations:

For Windows 7 and Windows 10, save ActivationFile.xml at:

(for 32 bit)  C:\Program Files\S&C Electric\IntelliLink6 and  
C:\Program Files\S&C Electric\IntelliTeam Designer

(for 64 bit)  C:\Program Files (x86)\S&C Electric\IntelliLink6 and  
C:\Program Files (x86)\S&C Electric\IntelliTeam Designer

or if lacking Administrative Privilege, save the ActivationFile.xml file at:

C:\Users\username\AppData\Local\S&C Electric

For Windows 2008 Server R2, save ActivationFile.xml at:

(for 32 bit)  C:\Program Files\S&C Electric\IntelliLink6 and  
C:\Program Files\S&C Electric\IntelliTeam Designer

(for 64 bit)  C:\Program Files (x86)\S&C Electric\IntelliLink6 and  
C:\Program Files (x86)\S&C Electric\IntelliTeam Designer

or if lacking Administrative Privilege, save the ActivationFile.xml file at:

C:\Users\username\AppData\Local\S&C Electric

If the instructions above fail to activate the software applications, delete the ActivationFile.xml from all existing locations on the computer and save the new ActivationFile.xml in the following directory:  C:\Users\Public\Public Documents\S&C Electric.

Note: This fix only applies to Windows 7, Windows 10, and Windows 2008 Server R2 users and is only supported by IntelliLink6 revision 608.8 and later.
Online Activation

The IntelliTeam Designer **Online Activation** function communicates with the S&C Automation Customer Support Portal and allows users to download and activate their IntelliTeam Designer application online. This significantly streamlines the activation process because once a user logs in to the portal and becomes an activated user, IntelliTeam Designer will download and store the activation file on the user’s computer with no manual intervention required. There is also an option to download the activation file automatically each time a user logs in to the portal, so the user is always working with the most recent activation file that includes all available IntelliTeam licenses and assets.

Follow these steps to use online activation:

**STEP 1.** In the IntelliTeam Designer **Start Page** screen, click on the **Activate** link on the left side.

**STEP 2.** On the right side of the screen, click on the **Online Activation** button to load the online activation customer portal **Login** screen. See Figure 8.

**Note:** If the **Online Activation** button is not displayed, go to the Start page. Click on the **Options** button on the left, click on the **Configuration** button, and put a check mark in the **Online Activation** box.

![Figure 8. IntelliTeam Designer Start Page, Online Activation Login screen.](image-url)
Non-activated Computer
Follow these steps to get the activation file for a non-activated computer:

**STEP 1.** Enter the customer portal username and password to log in to the portal.

**STEP 2.** When logged in, the IntelliTeam Designer program will activate the MAC address of the computer and then automatically download the activation file to the computer. This will exit the Trial mode and activate IntelliTeam Designer so it can be used to configure the IntelliTeam system using the existing IntelliTeam system-enabled field devices.

**STEP 3.** To enable automatic downloads, click on the *Automatically Download Activation File* button. It will then change to “enabled” for that option.

**STEP 4.** Log out of the customer portal.

Activated Computer
Follow these steps to get the activation file for an activated computer:

**STEP 1.** Enter the customer portal username and password to log in to the portal.

**STEP 2.** When logged in, click on the *Download Activation File* button. This will download the existing activation file from the customer portal account and replace the one that is currently on the computer.

**STEP 3.** To enable automatic downloads, click on the *Automatically Download Activation File* button. It will then change to “enabled” for that option.

**STEP 4.** Log out of the customer portal.
Software Installation

Online Activation Options

Check for Updates
Click on the Check for Updates button; it will check the customer portal to see whether there is a new activation file available with a new expiration date.

Download Activation File
Click on the Download Activation File button; it will download the existing activation file from the customer portal.

Note: If the computer is not activated, the IntelliTeam Designer program will not allow downloading the activation file. Activate the computer first before selecting the activation file download.

Deactivate/Activate Computer
Click on the Deactivate/Activate Computer button; it will either deactivate the computer from the customer portal (remove the MAC address) or activate the computer in the customer portal (add the MAC address), depending on the button display (Deactivate or Activate).

Note: This is no longer an option in IntelliTeam Designer 7.3.x.x and later releases because the requirement to register MAC addresses has been removed in those releases.

Automatically Download Activation File
Click on the Automatically Download Activation File button; it will either enable or disable automatic downloads of the activation file upon login to the customer portal from the IntelliTeam Designer interface. By default, this option is disabled. When enabled, the IntelliTeam Designer program will automatically download and replace the activation file on the computer when a user logs into the customer portal.
The first screen that appears when IntelliTeam Designer is launched is the Start page. It’s a quick way to preview recently opened circuits, set options, and view information about IntelliTeam Designer. The navigation buttons are shown in Figure 9. When IntelliTeam Designer is already open, access the Start page by selecting the File tab in the top menu and clicking on the Close button.

**Figure 9.** IntelliTeam Designer Start Page navigation buttons.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Draw</strong></td>
<td>Enters <strong>Draw</strong> mode and starts a new circuit</td>
</tr>
<tr>
<td><strong>Open Circuit</strong></td>
<td>Opens a circuit for editing in <strong>Draw</strong> mode</td>
</tr>
<tr>
<td><strong>Instant Replay</strong></td>
<td>Enters <strong>Instant Replay</strong> mode with an empty circuit</td>
</tr>
<tr>
<td><strong>Open Replay Log</strong></td>
<td>Opens a replay log for viewing in <strong>Instant Replay</strong> mode</td>
</tr>
<tr>
<td><strong>Recent</strong></td>
<td>Shows recently opened circuits and replay logs. Allows a circuit to be previewed</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>Set persistent options and sound effects for <strong>Instant Replay</strong></td>
</tr>
<tr>
<td><strong>Activate</strong></td>
<td>Activates the IntelliTeam Designer application either via the offline or online activation processes</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>This provides an overview of What’s New in the release, IntelliTeam Designer Help Documentation, and About IntelliTeam Designer</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Closes the IntelliTeam Designer program</td>
</tr>
<tr>
<td><strong>Show Start Page on Startup</strong></td>
<td>If checked, the Start page is the first screen to appear when IntelliTeam Designer is launched. If unchecked, IntelliTeam Designer will launch in <strong>Draw</strong> mode</td>
</tr>
</tbody>
</table>
Recent Option

The **Recent** button allows viewing recently opened circuits and replay logs. To preview a circuit, click on the file name, and the circuit will be drawn in the “Circuit Preview” workspace. See Figure 10.

To open a circuit, double click the file name, or click on the **Open File** icon on the left side of the file name to open.

![IntelliTeam Designer Recent Files screen.](image)

Depending on the file type, it will open in either **Draw** mode or **Instant Replay** mode. The icon next to the file name will indicate the mode in which the file would open.

- **Open File**
- **Draw Mode**
- **Instant Replay Mode**
- **Pin File**
- **Remove File**

Click on the **Clear** button at the bottom to remove all entries in the Recent Files list.

To change the number of visible items in the Recent Files list, modify the number listed at the **Quickly access this number of documents** setting.
The following workflow steps will help quickly build the circuit and configure the IntelliTeam SG system; save the work at any step:

**STEP 1.** Launch IntelliTeam Designer. Open a file or create a new file from the file menu.

**STEP 2.** Place the sources and distributed generation devices (available in 7.3.x.x and newer). See Figure 11.

**STEP 3.** Place the wire-connection points.

**STEP 4.** Draw wires between sources and wire-connection points.

**STEP 5.** Place switches on the wires, and rename switches as preferred.

**STEP 6.** Establish the normal state of each switch, set the hinge side, and set sensor location.

**STEP 7.** Run the **Validate** option to automatically generate team associations.

**STEP 8.** Correct any attribute errors or warnings as necessary.

**STEP 9.** Change the default team names to the names wanted.

**STEP 10.** Save the file.

**STEP 11.** Setup attributes.

**STEP 12.** Add any annotations such as text, lines, boxes, and images.

**STEP 13.** Toggle the **Show Wire Connections** entry in the **Option** menu to hide all wire connections.

**STEP 14.** Save the file. The IntelliTeam SG system configuration is complete.
Figure 11. Workspace option locations.

**Workspace**

**Miscellaneous Tools**

- **Zoom Wheel**: Clicking on this icon puts the mouse wheel into zoom mode.
- **Validate Tool**: This icon runs a validation check of the netlist and device attributes.
- **Communicate to Devices**: This icon connects to an entry-point device to configure the IntelliTeam SG system.
- **Show Grid**: This icon toggles the drawing grid on and off. Objects automatically snap to the grid when this feature is on.
**Tools and Features**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td><strong>Show Full Screen</strong></td>
<td>This icon toggles to hide or show the Side Bar and Configuration Display to allow more drawing space.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Undo</strong></td>
<td>This icon reverses the last operation, up to 100 steps.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Redo</strong></td>
<td>This icon reverses the last undo, up to 100 steps.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Magnifying Glass</strong></td>
<td>Clicking on this icon turns the mouse cursor into a magnifying glass. Select the zoom percentage using the combo box to its right. The magnifying glass can also be turned on by pressing the (&lt;\text{Shift})&gt; key and the Left mouse button inside the circuit.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Zoom In</strong></td>
<td>Clicking on this icon zooms into the circuit view.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Zoom Out</strong></td>
<td>Clicking on this icon zooms out of the circuit view.</td>
</tr>
</tbody>
</table>

**Drawing Tools**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td><strong>Select Item</strong></td>
<td>This icon is the item-selection tool for moving objects. Press and hold the (&lt;\text{Ctrl})&gt; key to select multiple objects. Selected objects are bordered and remains selected until a place object tool is selected.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Pan Mode</strong></td>
<td>This icon allows easy panning, rather than holding the (&lt;\text{Alt}&gt;) key and moving the mouse. To exit pan mode, click the <strong>Select Item</strong> (white arrow) button to go back to item selection.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Repeat Insert</strong></td>
<td>Click once to select it. Click it a second time to unselect. When the <strong>Repeat Insert</strong> button is selected, the active object insert tool remains active allowing multiple inserts.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Add Source</strong></td>
<td>This icon places one source object in the drawing area unless the <strong>Repeat Insert</strong> button is selected to allow multiple sources to be inserted.</td>
</tr>
</tbody>
</table>
Add DG Device

This icon places one distributed generation (DG) device in the drawing area unless the Repeat Insert button is selected to allow multiple DG devices to be inserted. A DG device must be connected to a single IntelliTeam system device, such as an IntelliRupter® fault interrupter, 6800 Switch Control, 6801M Switch Operator, IntelliNode/UIM, or IntelliNode/Info-Only module.

Note: A new device has been added to IntelliTeam Designer called an IntelliNode/Info-Only module, designated with an “IO #” label as shown in Figure 12. This device is only used when an IntelliNode interface module is installed as a stand-alone device in the field and is communicating to a DG protection device (e.g. relay, breaker) via DNP3 remotely. If the IntelliNode module is physically installed with a device, the traditional IntelliNode/UIM module type is used instead. An Info-Only device takes part in all normal team activity but cannot initiate a team transfer event, nor can it be selected as a switch to open or close during normal restoration and reconfiguration. There are four new validation rules that go along with an IntelliNode/Info-Only module:

- It must be connected to a DG device on one side and be part of a normal IntelliTeam system team on the other side.
- It cannot be excluded from the circuit.
- It cannot be a normally open device.
- It cannot be part of a closed-loop circuit.

![Figure 12. The IntelliNode/Info-Only module.](image)
Add Device Switch

This icon places one device switch object in the drawing area unless the Repeat Insert button is selected to allow multiple switches to be inserted. This can be dropped onto a wire and it will merge automatically.

IntelliRupter Device Object

The IntelliRupter fault interrupter is the default device, with Y at the jaw. If changing to a 6800 Series Switch Control or IntelliNode Interface Module, the X is removed and the voltage sensor is correctly placed on the jaw side by default. It is important to ensure the actual placement of the voltage sensor in the field, either jaw or hinge side, is reflected in the drawing of the device as this is used by IntelliTeam system to determine load directionality.

The default voltage sensor orientation can be changed by using the Toggle Terminal icon in the drawing area. See Figure 13.

The list of single-switch device types is: IntelliRupter, IntelliNode/UIM, IntelliNode/Info-Only, PadMount Single 1V, 6801-E33, 6801-Scada-Mate, 6801 Universal, 6801M-E33, and 6801M. The images that represent each device type are shown here.

Figure 13. The Toggle Terminal icon dialog box in the drawing area.
Note: Wire the sources together first. When a switch is dropped in the middle of a wire, it automatically connects itself on both sides of the wire. It will also automatically rotate itself to connect to a vertical wire.

Note: When placing a device on a vertical wire make sure the mouse cursor completely covers the wire. If the device is not placed on the wire, click on the Undo button and try again.

Add 2 Switch

This icon adds two switches in the drawing area unless the Repeat Insert button is selected to allow multiple wires. This is to support the 6802 control, which has two switches that share the same IP, RTU, and serial number data.

PadMount Dual 2V is the default. All multi-switch devices have been converted to this type. Other device types available are: PadMount Dual 1V, 6802-OverheadST, 6802-Universal, 6802-Vista. These are shown in Figure 14 on page 26 and can be toggled in the Visual Properties area.

Note: The PadMount Dual 1V must have the sensor on the internal bus. If this switch is toggled to change the sensor orientation where the sensor is facing the incoming side of the device, a validation error will occur and require the sensor to be placed on the internal bus in order to validate a circuit.

Add Wire

This icon adds a wire in the drawing area unless the Repeat Insert button is selected to allow multiple wires.
Figure 14. Multi-switch device types.

**Note:** Zoom in as much as possible, keeping both devices to be wired together on the screen. It will make connecting the wires easier. Close the configuration dialog boxes to make the drawing area larger to allow a bigger zoom.

![Incremental Zoom](image)

**Incremental Zoom**

This icon allows zooming with the mouse wheel by selecting the **mouse wheel toggle** button. Select the button again to resume normal operation. Zooming is centered at the location of the mouse pointer.

![Add Wire Connection](image)

**Add Wire Connection**

This icon inserts a wire connection point unless the **Repeat Insert** button is selected to allow multiple wire connections to be inserted. A wire connection point is needed to electrically join two wires. This can be dropped onto a wire, and it will merge automatically like a switch. This is helpful to make “T” and right-angle connections.

![Add Text](image)

**Add Text**

This icon adds a text box for user defined labels.
Add Line

This icon adds a static line to the drawing. Line color, thickness, and style can be changed through the Visual Property field after the horizontal line has been placed. See Figure 15.

Note: This annotation can be rotated to any angle. Select the line with a mouse click or with Component Explorer, and the rotate option (white circle at the top) will appear. Hover the cursor over the white circle until a white arc with two arrows appears. Left click and drag the cursor left or right to rotate.

Figure 15. Component Explorer dialog box.

Add Box

This icon adds a static box to the drawing. Line color, thickness, and style can be changed through the Device Editor dialog box after the box has been placed.

Add Image

This icon adds an image box to the drawing. To add an image to the drawing, click on the Add Image icon. Then, place it on the drawing and an image box will appear that looks like an S&C logo. Use the Browse button to locate the image file to be displayed in the image box. The Image Editor will display when an image box has been selected. It will be on the right side of the workspace, in the Visual Properties area. See the workspace in Figure 12 on page 23 and Figure 16 on page 28.
Figure 16. The Visual Properties dialog box.

Rotate Switch or Source

Click on the Rotate Switch or Source tool to select it. The tool remains selected until clicked a second time. Click on a device to rotate it. Only the connection handles are affected by the rotate operation when applied to a source.

Toggle Switch Open/Close

This tool is used to set the normal state of all switching devices in the drawing. It has no effect on a source. This tool remains selected until it has been unselected by clicking it a second time.

**Note:** Set all normally open devices before running the **Validate** function to avoid unnecessary errors.
Tools and Features

Sensor locations entered on the IntelliTeam Designer diagram are now automatically configured in the controls. This means it is necessary to have an accurate representation of sensor locations in the IntelliTeam Designer diagram. For the devices in the field, there is only one requirement for a specific sensor location, so it can always detect source voltage and the normal current flow is from the sensor side of the switch to the non-sensor side of the switch. The first device outside the substation must have its sensors on the substation side when the substation breaker is not a team member. The Toggle Terminal tool allows creation of an accurate representation of the system, but these settings must be configured at each device.

To have IntelliTeam Designer remember the device attributes of an excluded device, the circuit must be validated and saved before exiting the application. Then, when the device is re-included, IntelliTeam Designer will populate the saved device attributes. If the excluded device is a two-switch device, it will be reverted to a PadMount device, so if it is any other type of two-switch device, it will then need to be modified in the Visual Properties area.

Toggle Terminal

This icon flips the 1 and 2 terminal designations shown on the diagram for a switch. The device sensor terminal relation will remain the same and the sensor will follow the terminal as it is moved. For IntelliRupter, Terminal 1 = the X terminal, and Terminal 2 = the Y terminal. This tool remains selected until it has been unselected by clicking it a second time. The Y terminal follows the Jaw side for an IntelliRupter fault interrupter, and the sensor follows the Jaw side for a 6800 Series switch.

Exclude/Include

This icon converts a switch to a wire, or it converts a source to an end load and removes the switch from the team. It can be used for drawing manually operated switches in pad-mounted gear. For an IntelliRupter fault interrupter the X and Y terminal designations are removed, but IntelliTeam Designer remembers them if the IntelliRupter fault interrupter is subsequently included.

Exclude/Include Open

This icon converts a switch to an open manual switch and removes the switch from the team. It can be used for drawing manually operated switches in pad-mounted gear. For an IntelliRupter fault interrupter the X and Y terminal designations are removed, but IntelliTeam Designer remembers them if the IntelliRupter fault interrupter is subsequently included.

Sensor locations entered on the IntelliTeam Designer diagram are now automatically configured in the controls. This means it is necessary to have an accurate representation of sensor locations in the IntelliTeam Designer diagram. For the devices in the field, there is only one requirement for a specific sensor location, so it can always detect source voltage and the normal current flow is from the sensor side of the switch to the non-sensor side of the switch. The first device outside the substation must have its sensors on the substation side when the substation breaker is not a team member. The Toggle Terminal tool allows creation of an accurate representation of the system, but these settings must be configured at each device.

To have IntelliTeam Designer remember the device attributes of an excluded device, the circuit must be validated and saved before exiting the application. Then, when the device is re-included, IntelliTeam Designer will populate the saved device attributes. If the excluded device is a two-switch device, it will be reverted to a PadMount device, so if it is any other type of two-switch device, it will then need to be modified in the Visual Properties area.
### Tools and Features

#### File Menu

**File > New**
When selected, IntelliTeam Designer clears the circuit diagram but does not exit the application.

**File > Open**
When selected, a file prompt will appear to select a circuit to open.

**File > Recent Files**
This menu contains a list of recently opened files. Recent files are added to the top of the list and will remove the oldest file if it exceeded the list limit. Clicking on the file will open the circuit. Clicking on the pin will keep the file at the top and will not remove it from the list even if the list exceeds the limit. Clicking on the X button will remove it from the list. See Figure 17.

![Figure 17. Recent Files button.](attachment:image.png)
Tools and Features

File > Close
When selected, IntelliTeam Designer clears the circuit diagram and enters the Start page.

File > Save
When selected, IntelliTeam Designer saves the circuit to a file. If a circuit is opened, it will overwrite it. Otherwise, it will prompt for a new file name.

File > Save As
When selected, IntelliTeam Designer saves the circuit to a file. It will always prompt for a new file name.

File > Save As Image...
This menu saves the circuit diagram in a different image format, such as pdf, svg, wmf, gif, jpg, tif, and png.

File > Exit
When selected, it will close IntelliTeam Designer.

System Menu
This contains all menu options related to database access and is only available for users who have that access as part of their activation file. See Figure 18.

Figure 18. The System menu.
**Tools and Features**

### Circuit Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circuit &gt; Print Preview</td>
<td>When selected, a new pop-up screen will be displayed asking which page size should be used. Options are 8.5x11, Plotter B (11x17), Plotter C (17x22), Plotter D (22x34) and Plotter E (34x48). Once a page size is selected, a print dialog box will open and show the current drawing. Print the image, zoom in or out, and preview the different pages that will be printed.</td>
</tr>
<tr>
<td>Circuit &gt; Print Landscape</td>
<td>When selected, this will make the circuit image print in landscape format instead of portrait format.</td>
</tr>
<tr>
<td>Circuit &gt; Zoom In</td>
<td>When clicked on, this will zoom in on the existing circuit drawing.</td>
</tr>
<tr>
<td>Circuit &gt; Zoom Out</td>
<td>When clicked on, this will zoom out on the existing circuit drawing.</td>
</tr>
<tr>
<td>Circuit &gt; Validate</td>
<td>When clicked on, this will attempt to validate the existing circuit drawing.</td>
</tr>
<tr>
<td>Circuit &gt; Auto Validate On Open</td>
<td>When selected, this will automatically validate the existing circuit when it is re-opened in IntelliTeam Designer.</td>
</tr>
<tr>
<td>Circuit &gt; Auto Validate On Save</td>
<td>When selected, this will automatically validate the existing circuit when the circuit is saved in IntelliTeam Designer.</td>
</tr>
<tr>
<td>Circuit &gt; Validate Unique IP</td>
<td>When selected, this will verify that all devices have a unique IP address configured on the existing circuit.</td>
</tr>
<tr>
<td>Communication to Devices</td>
<td>When selected, this will launch the communication manager in IntelliTeam Designer.</td>
</tr>
</tbody>
</table>

### Edit Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit &gt; Find</td>
<td>When selected, it opens a floating dialog box for finding objects in the circuit.</td>
</tr>
<tr>
<td>Edit &gt; Undo</td>
<td>When selected, this reverses the last operation, up to 100 steps.</td>
</tr>
<tr>
<td>Edit &gt; Redo</td>
<td>When selected, this reverses the last undo, up to 100 steps.</td>
</tr>
<tr>
<td>Edit &gt; Select All</td>
<td>When selected, this selects all drawing items so they can be edited together.</td>
</tr>
</tbody>
</table>
Tools and Features

Group Tools

- **Align Top**: This icon brings the top of all selected objects up to the top of the highest object in the selected group.
- **Align Left**: This icon brings the left side of all selected objects to the left side of the far left object in the selected group.
- **Align Bottom**: This icon brings the bottom of all selected objects down to the bottom of the lowest object in the selected group.
- **Align Right**: This icon brings the right side of all selected objects to the right side of the far right object in the selected group.
- **Space Horizontally**: This icon spaces all selected objects evenly between the right and left object of the selected group.
- **Space Vertically**: This icon spaces all of the selected objects evenly between the highest and lowest of the selected objects.
- **Group Delete**: This icon deletes all of the selected objects.

Options Menu

All menu options are remembered for the next IntelliTeam Designer session except where explicitly specified that it is not remembered.

- **Show Full Screen**: When selected, the other sections are collapsed to fully expand the diagram. This option is not remembered.
- **Show Grid**: When selected, it shows the grid points on the screen.
- **Show Classic Background**: When selected, it changes the diagram background color to light gray. When not selected, the background color is slate gray.
- **Show Wire Connection**: When selected, it shows a black dot in the diagram to represent a wire connection.
- **Align Wire to Grid**: When selected, it snaps objects to the grid points.
**Tools and Features**

- **Component Explorer Center Selection**
  When selected, it centers on the object that is selected in the Component Explorer.

- **Show Replay Pointers**
  When selected, pointers will appear during the Instant Replay session to highlight which devices operated. This is only available in the **Instant Replay** mode.

- **Reverse Switch Colors**
  When selected, it converts drawing colors to the reverse standard, from red closed switch to green closed switch. See Figures 19 and 20.

![Figure 19. Standard drawing with default color scheme for switches.](image1)

![Figure 20. Reversed switch color scheme.](image2)

- **Auto Refresh Labels at Validation**
  When selected, it automatically enables the labels for switches and sources if the labels have data (such as RTU for a switch).

- **Show Anchor Markers**
  When selected, it shows small circles where a wire can be connected to the circuit object.

- **Prompt for Swap Switch Positions**
  When the **Add 2 Switch** button is used to create a switch pair, this option swaps the Switch 1 and Switch 2 names. See Figures 21, 22, and 23 on page 35.

  Clicking the menu item will swap the switch positions even after insertion. The **Swap Switch Positions** command is also available as a right-click option.
Figure 21. Options Menu: Prompt for Swap Switch Positions dialog box.

Figure 22. Switch positions before they are swapped.

Figure 23. Switch positions after being swapped.
**Tools and Features**

**Propagation Version**
This option, for version 7.1.x of IntelliTeam Designer, is called “New Propagation Version” and is enabled by default. This is used by device firmware 7.1.x to push the netlists to the controls. If the controls are using an older version of software, disable this by unchecking it.

For the 7.3.x version of IntelliTeam Designer, this now has three options: 6.3 and earlier, 7.1, and 7.3 (selected by default). To push a netlist, make sure the devices are all running the same firmware version. This option must be configured to match that firmware version. If they do not match, an error will be seen during a netlist push indicating there is a mismatch.

**Note:** This option has been removed in IntelliTeam Designer version 7.5.x and above. Version 7.5.x and above will automatically detect which firmware version the devices are running when using the communication manager and running a communications check, then the appropriate netlist will be pushed to the devices.

**IntelliTeam II Setpoint Configuration**
This option, for version 7.5.x of IntelliTeam Designer and above, puts the IntelliTeam Designer application into IntelliTeam II Setpoint Configuration mode where it will generate IntelliLink® Setup Software .xspt configuration files that can either be pushed to the devices by the communication manager in IntelliTeam Designer or can be programmed into the devices using the IntelliLink Setup Software application. This option is disabled by default and supports firmware releases 6.1, 6.3, 7.1, 7.3, 7.4, and 7.5. IntelliLink setpoint files will be saved in the same directory where the IntelliTeam Designer circuit is saved on the computer’s hard drive.

**Note:** When this option is enabled and a circuit is drawn, it must be saved first before the setpoint files will be generated. Also, The **IntelliTeam Options Enabled** setting in the **Team Attributes** tab and **Substation Team Attributes** tab must be set to **ITII** mode to generate the setpoint files or validation errors will occur.

**Enable IntelliTeam FMS Export**
When selected, it enables the IntelliTeam® FMS Feeder Management System export.

**Enable Sound Effects**
When selected, it turns on sound effects for Instant Replay events. Only available in the **Instant Replay** mode.
### Tools and Features

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show Admin Options</strong></td>
<td>When selected, this shows the administrator options in the System menu that allow an administrator to manage users.</td>
</tr>
<tr>
<td><strong>Show Notification Timestamps</strong></td>
<td>When selected, this shows timestamps for all Error states, Warning states, and informational notifications that occur within the application.</td>
</tr>
<tr>
<td><strong>Show Error Notifications</strong></td>
<td>When selected, this shows error notifications in the application when Error states occur.</td>
</tr>
<tr>
<td><strong>Show Warning Notifications</strong></td>
<td>When selected, this shows warning notifications within the application when Warning states occur.</td>
</tr>
<tr>
<td><strong>Show Info Notifications</strong></td>
<td>When selected, this shows information notifications within the application as they occur.</td>
</tr>
</tbody>
</table>

#### Pinned Dialog Boxes

**Side Bar Pin**: These pins are located on the upper right of each dialog box. They pin and unpin the dialog box containing the Component Explorer, the Visual Property Editor, the Tree View, or the Configuration Display. See Figures 24, 25, and 26 on page 38.

**Note**: When the Component Explorer Center Selection entry is checked in the Options menu, the object selected in the Component Explorer is moved to the center of the drawing area. Use this feature to view a specific device after the zoom function has placed it off screen.

**Note**: Large zoom changes may result in an empty drawing dialog box. Use the Component Explorer to bring the drawing objects back into the dialog box.

**Note**: Selecting a device in the Component Explorer populates the device attributes in the Visual Property dialog box.
Figure 24. The Component Explorer dialog box.

Figure 25. The Visual Properties dialog box.

Figure 26. The Tree View dialog box.
Floating Dialog Boxes

The Component Explorer, Visual Properties, Tree View, and Find Item dialog boxes can be dragged from their anchor position and become floating dialog boxes. To make it a floating dialog box, click and hold the title and drag it away from the anchor position. To re-anchor the dialog box, click and hold the dialog box’s title and drag it back into the anchor position. See Figures 27 and 28.

Figure 27. Component Explorer as a floating dialog box.

Figure 28. Find Item as a floating dialog box.
Configuration Display Pin and Tab

The pin is located on the lower right of the workspace. This hides the configuration display or pins it to remain shown.

When the configuration display is hidden, the tab is the only one shown on screen. Hovering over or clicking on it will show the configuration display until the mouse is moved away from the tab and click on other pins. See Figure 29.

![Figure 29. Configuration display.](image)

Validation Errors and Warnings

The Configuration Display area will show a green check mark with 0 Errors and 0 Warnings if the circuit is valid and no validation errors or warnings occur when a circuit is validated. If there are errors or warnings, a message will open along with notes in the Description area explaining why errors or warnings occurred. See Figure 30.

![Figure 30. The Circuit Errors or Warnings dialog box.](image)
### Device Attributes Tab

This tab contains the Device ID, RTU, IP, Serial Number, and CEC Allowed attributes. A field can be sorted by clicking a column header. The first click sorts ascending and the second click sorts descending. All Attributes tab fields can be sorted. The values may be edited directly in the table or in the side panel configuration area.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device ID</strong></td>
<td>Device identification, automatically assigned when a device is placed in the schematic, user configurable and must be unique</td>
</tr>
<tr>
<td><strong>RTU</strong></td>
<td>The DNP address for the device; a unique DNP address must be supplied for each device</td>
</tr>
<tr>
<td><strong>IP</strong></td>
<td>The IP address for the device; only required when Ethernet communication is used with the device</td>
</tr>
<tr>
<td><strong>Serial Number</strong></td>
<td>The device serial number; only serial numbers that are contained in the license Activation File can be used</td>
</tr>
<tr>
<td><strong>CEC Allowed</strong></td>
<td><strong>True</strong>—Enables communication-enhanced coordination (CEC) for an IntelliRupter fault interrupter (It is only applicable for an IntelliRupter fault interrupter. CEC only functions in systems with IntelliRupter fault interrupters or with an IntelliRupter fault interrupter or a substation IntelliNode Interface Module as the head end device. It does not work in systems with 6800 controls or IntelliNode modules on field devices.) <strong>False</strong> (default)—Disables CEC</td>
</tr>
</tbody>
</table>

**Note:** IntelliTeam Designer uses the X (red terminal 1) and Y (blue terminal 2) bushings for CEC, so these must be setup in the application exactly how the IntelliRupter fault interrupter is set up in the field.
Tools and Features

Team Attributes Tab

Contains the Switch Team ID, Team Record Number, Alternate Sources, Line Segment Limit, Contracts Required, Return to Normal Time, Prohibit Restoration Time, IntelliTeam Options Enabled, and Load Priority attributes. A field can be sorted by clicking a column header. The first click sorts ascending and the second click sorts descending. All Attributes tab fields can be sorted. The values may be edited directly in the table or in the side panel configuration area. See Figure 31.

Team ID

Automatically populated when a Validate operation is run (This is the designation used by the IntelliTeam SG system to identify each line segment bounded by IntelliTeam SG devices.)

Team Number

Automatically populated when a Validate operation is run (Each team number is listed in the table shown on the IntelliTeam>Operation>Team Summary, and the IntelliTeam>Setup>Team Summary screens. The row for each team number shows the devices that belong to that team. A device can be a member of more than one team. Also, IntelliTeam Designer only uses eight team numbers, so these may be repeated on large circuits. Therefore, the team ID and team number make-up the team identifier.)

Note: When selecting the Team ID in the Configuration dialog box, the team ID (T1) and all team members (DS2, DS3, and DS4) are highlighted on the circuit shown in the workspace. See Figure 29 on page 40.

Figure 31. Team Attributes tab in the Configuration dialog box.
Tools and Features

**Alternate Source**

**User Setting**—The default is **none**. Set the priorities for the different ways the team members can restore a line segment. If the team cannot use the source, designated as “Source” by IntelliTeam Designer, to restore the line segment, then the team tries the members configured in these setpoints.

If these setpoints are not configured, or if the selected team members cannot be used to restore the segment, the team first tries the members IntelliTeam Designer designates as “Tie” to find an alternate source. If that is not successful, the team tries the members IntelliTeam Designer designates as “Load Tie.”

Each team can have up to four alternate sources prioritized. The first alternate source will be tried first and the fourth alternate source will be tried last, if all four alternate sources are populated. To set alternate source priorities, select the team by highlighting it in the Team ID column, and select a Rec number from the pull down box next to each alternate source. The Rec number is automatically assigned to each team member by IntelliTeam Designer and will have the appropriate team member associated with it. To see the device association, use the pull-down menu located below the Team Attribute Editor label, and hover the mouse cursor over the pull-down box to display the record association.

**Note:** Alternative source selection is only applicable when the IntelliTeam system uses **IntelliTeam II** logic to restore line segments. It will not be used by the **Rapid Self-healing** (RSH) logic because that logic will find a source that can restore all line segments through a “Tie” point.

**Line Segment Limit**

**User Setting**—The default setting is **N/A**, which allows picking up as many line segments as capacity allows. Set this to the maximum number of line segments this team can pick up. For example, Add 1 inhibits any other line segments from being restored through a member after it restores its first line segment. To allow the team to pick up as many line segments as capacity allows, set this value to N/A. This setting is only used when the IntelliTeam SG system uses the **IntelliTeam II** logic to restore line segments.
### Contracts Required

**User Setting**—The default setting is **No**, which does not use contracts. If a circuit is bifurcated, multiple events can result in an overload if contracts are not used. To avoid overloading on bifurcated circuits, set this to a **Yes** value. When team members encounter a line segment in a restoration path that requires a contract, they will communicate with all subsequent line segments in the direction of the alternate source to ensure that the alternate source will not be overloaded. This also slows down the reconfiguration process. Contracts are only used when the IntelliTeam SG system uses **IntelliTeam II** logic to restore line segments.

### Return to Normal Time (mins)

**User Setting**—This setting is the amount of time, in minutes, that power must be restored to the faulted line segment before the **Return to Normal** process will start. Range: 1 to 254 minutes; Default: 5 minutes.

### Prohibit Restoration Time (mins)

**User Setting**—The default setting is **0**, and the IntelliTeam SG system continues to look for a restoration solution indefinitely. Set this value to the length of time desired to allow this team to attempt to restore service after an event has begun. If this timer expires before restoration of service, the team will enter the **Prohibit Restoration** state, preventing any further restoration activity by this team until the **Prohibit Restoration** state is cleared through the appropriate SCADA command or on the Operation screen in the IntelliLink Setup Software by enabling the **IT SG Restoration** button.
IntelliTeam Options
Enabled

User Setting—The default is ITSG.

Disabled
All IntelliTeam functionality is turned off and disabled

ITII

Puts the selected device in **IntelliTeam II Compatibility** mode. This setting is used when setting up a device to operate in an IntelliTeam II system with 5800 Series Automatic Switch Controls. All devices in a given circuit must be using **IntelliTeam II Compatibility** mode for this option to be used.

**Note:** IntelliTeam Designer cannot push settings to a 5800 Series Automatic Switch Control. These controls need to be configured using the IntelliLink Setup Software. Also, this mode is not compatible with distributed generation and cannot be used when there are distributed generation devices on the circuit.

**Note:** To configure the system in **IntelliTeam II Compatibility** mode without runners using IntelliTeam Designer version 7.1.x - 7.3.x, (i.e. legacy **IntelliTeam II** mode with only coach traffic), the **Clear Feedernets** button in the communication manager must be clicked after the netlists have been successfully pushed to all of the team devices. To verify that a system is in this mode of operation, go to the Historic Log in the IntelliLink Setup Software and verify **ITII** mode is in the **Active** state. Otherwise, this mode uses runners and will increase traffic on the communications system unnecessarily. Refer to S&C Instruction Sheet 1044-577, “IntelliTeam® Designer: IntelliTeam® II Setup and Configuration,” for more information about **IntelliTeam II Compatibility** mode of operation.

**Note:** To configure the system in **IntelliTeam II** mode using IntelliLink Setup Software setpoint files, all devices need to be configured with the **IntelliTeam Options Enabled** setting in **ITII** mode. Refer to S&C Instruction Sheet 1044-577, “IntelliTeam Designer: IntelliTeam II Setup and Configuration,” for more information.
**ITSG**

Puts the selected device in *IntelliTeam SG* mode, with **Rapid Self-Healing** mode turned off (This mode uses *IntelliTeam II*-system style restoration and has both runners and coaches being used.)

**Note:** This mode is not compatible with 5800 Series Automatic Switch Controls, but it is compatible with distributed generation devices on the circuit.

**ITSGwRapidSelfHealing**

Puts the selected device in *IntelliTeam SG* mode with **Rapid Self-Healing** mode turned on (**Rapid Self-Healing** mode must be turned on to enable the **Post Restoration Load Management** mode.)

**Note:** This mode is compatible with distributed generation devices on the circuit.

**ITSGwPLIsolation**

Puts the selected device in *IntelliTeam SG* mode with **Phase Loss Isolation** mode enabled (Phase-loss isolation looks for a loss of phase voltage and will then isolate the effected teams and restore around them as necessary. This option can only be used with devices that support three-phase voltage sensing.)

**Note:** This mode is compatible with distributed generation devices on the circuit.

**ITSGwRapidSelfHealingAndPLIsolation**

Puts the selected device in *IntelliTeam SG* mode with **Rapid Self-Healing** and **Phase Loss Isolation** modes turned on (This option can only be used with devices that support three-phase voltage sensing. Refer to S&C Instruction Sheet 1044-575, “*IntelliTeam® Designer: Phase-Loss Isolation,*” for more information on phase loss isolation.)

**Note:** This mode is compatible with distributed generation devices on the circuit.
<table>
<thead>
<tr>
<th>Load Priority</th>
<th>User Setting—The default is <strong>Priority1_No Transfer</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Priority1_No Transfer</strong></td>
<td>Load shedding or transferring not allowed</td>
</tr>
<tr>
<td><strong>Priority3_Open Transfer</strong></td>
<td>Load shedding not allowed (Load transfer is allowed through an open transition only.)</td>
</tr>
<tr>
<td><strong>Priority4_Transfer Shedding</strong></td>
<td>Load shedding allowed (Only shed after transfers to other circuits have been considered. Priority 4 is the highest priority of this category.)</td>
</tr>
<tr>
<td><strong>Priority5_Transfer Shedding</strong></td>
<td>Load shedding allowed (Only shed after transfers to other circuits have been considered.)</td>
</tr>
<tr>
<td><strong>Priority6_Transfer Shedding</strong></td>
<td>Load shedding allowed (Only shed after transfers to other circuits have been considered.)</td>
</tr>
<tr>
<td><strong>Priority7_Transfer Shedding</strong></td>
<td>Load shedding allowed (Only shed after transfers to other circuits have been considered. Priority 7 is the lowest priority of this category and will be transferred or shed before Priority 6, 5, 4, etc.)</td>
</tr>
<tr>
<td><strong>Priority8_Shedding</strong></td>
<td>Load shedding allowed (Shed these loads before considering load transfers to other circuits. Priority 8 is the highest priority of this category.)</td>
</tr>
<tr>
<td><strong>Priority9_Shedding to Priority24 Shedding</strong></td>
<td>Load shedding allowed (Shed these loads before considering load transfers to other circuits.)</td>
</tr>
<tr>
<td><strong>Priority25_Shedding</strong></td>
<td>Load shedding allowed (Shed these loads before considering load transfers to other circuits. Priority 25 is the lowest priority of this category and will be shed before any others.)</td>
</tr>
</tbody>
</table>

**Team Member Attributes Tab**

**Team ID**

Automatically populated by running the **Validate** function; provides a unique designation used by the IntelliTeam SG system to identify each line segment bounded by IntelliTeam SG devices.
<table>
<thead>
<tr>
<th>Tools and Features</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device ID</strong></td>
<td>Automatically populated when a device is placed in the drawing environment. (Provides a unique designation used by the IntelliTeam SG system to identify each IntelliTeam SG device. The text can be modified but is limited to approximately six characters, and each ID must be unique. A text label placed with the Add Text tool is the recommended method for applying user-specific labels to each device.)</td>
</tr>
<tr>
<td><strong>Switch Position Number</strong></td>
<td><strong>User Setting</strong>—The default setting is Sw1. This field sets the switch ID for controls capable of controlling multiple switches under one RTU address. The setting for a single switch is Sw1.</td>
</tr>
<tr>
<td><strong>Maximum Capacity (amps)</strong></td>
<td><strong>User Setting</strong>—The default setting is 600. This field sets the maximum amount of load each device is allowed to carry. It should be set to the maximum rating of the switching device or the maximum amount of load the switch device is allowed to source, whichever is lower. Be sure to take into account cable/wire size and any other circuit restrictions. Also take into consideration the Substation Maximum Capacity setpoint because these two settings are used to determine how much load can be restored during an event. <strong>Note:</strong> When using the Post Restoration Load Management feature and enabling the Restore to Max Capacity Plus Overload option, the Overload Permitted setpoint is added to the switch’s Maximum Capacity setpoint as the new maximum capacity the switch can carry. Therefore, careful consideration should be taken when using that option if there are switches in the system that have lower maximum capacity values than what is being used at the substation.</td>
</tr>
<tr>
<td><strong>Return to Normal Mode (mins)</strong></td>
<td><strong>User Setting</strong>—The default setting is None, which means Return to Normal mode is disabled. This attribute determines the switching transition used by the Return to Normal mode. When enabled, the team members will return the circuit to its normal configuration once power is restored to the faulted line segment. For teams with one or more tie switches, choose the Open Transition mode, in which the tie switch(es) open before the other team members return the circuit to its normal configuration, or the Closed Transition mode, where the team members close all of the switches and then the tie switch(es) open. The Return to Normal process starts at the line sections closest to the normal source, then works outward. A single team member should have the same Return to Normal mode for each team where it is a member; however, a team may end up with members with different modes.</td>
</tr>
</tbody>
</table>
### Normal Switch Function

This definition states the role or function each switching device performs relative to its team. This setpoint is automatically populated when the Validate function is run. There are six possible designations:

**SourceSub**
- Assigned to the source device when it is the first team out of the substation or it is a IntelliNode Interface Module on a substation breaker.

**SourceLoadTie**
- Assigned to all switches in a closed-loop system because they are all tied to the sources on the closed loop.

**Source**
- Assigned to the normally closed device that provides power to the line segment when the team is in its normal configuration.

**LoadTie**
- A team may have zero to seven closed switches through which loads on other line segments receive power. This value is assigned when the switch could be involved in restoring power to the line segment because line segments on the other side of the switch have alternate sources.

**Load**
- A team may have zero to seven closed switches through which loads on other line segments receive power. This value is assigned when the switch could not be involved in restoring power to the line segment because line segments on the other side of the switch have no alternate sources.

**TieSub**
- Assigned when the tie switch is the first team member after the substation source (A TieSub switch should have its voltage sensors facing the alternate source.)

**Tie**
- Assigned to open switches in the team that restore power to the line segment directly from an alternate source when closed (A team may have zero to seven open switches.)

A team may have eight members. One Source or SourceSub and zero to seven in any combination of the other functional types.

**InfoOnly**
- Assigned to an IntelliNode/InfoOnly device only (An Info Only device takes part in all normal team activity but cannot initiate a team transfer event, nor can it be selected as a switch to open or close during normal restoration and reconfiguration.)
**Team Customer Counts**

This setting adds customer counts to each team that will be used by the IntelliTeam FMS Feeder Management System for reliability calculations (e.g. CAIDI, CMI, etc.). Six fields can be configured: Residential, Commercial, Industrial, Other 1, Other 2, and Other 3. The default entry is 0, but the default entries can be modified in the **Start-up** menu under **Options>Customer Counts**, shown in Figure 32.

- **Residential**
  - This is the number of residential customers within the team.
  - (Range: 0-100,000, Default: 0)

- **Commercial**
  - This is the number of commercial customers within the team.
  - (Range: 0-100,000, Default: 0)

- **Industrial**
  - This is the number of industrial customers within the team.
  - (Range: 0-100,000, Default: 0)

- **Other 1**
  - This is the number of type 1 other customers within the team.
  - (Range: 0-100,000, Default: 0)

- **Other 2**
  - This is the number of type 2 other customers within the team.
  - (Range: 0-100,000, Default: 0)

- **Other 3**
  - This is the number of type 3 other customers within the team.
  - (Range: 0-100,000, Default: 0)

![Figure 32. The start-up menu Options>Customer Counts section.](image)
<table>
<thead>
<tr>
<th>Substation Attributes Tab</th>
<th>Substation ID</th>
<th>Automatically populated by running the Validate function (Provides a unique designation used by IntelliTeam SG system to identify each substation.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Max Capacity As Disabled</td>
<td>Set Max Capacity As Disabled</td>
<td>Disables the Max Capacity setting for the selected source (When this check box is checked, the IntelliTeam system will use the calculated local capacity of first switch outside of the selected source (e.g., SourceSub or TieSub device) when it needs to restore loads.)</td>
</tr>
<tr>
<td>Maximum Capacity (amps)</td>
<td>Maximum Capacity (amps)</td>
<td>The maximum source capacity threshold defined as the maximum load a source can carry before it is considered to be an overload condition (This will be disabled if the Set Max Capacity as Disabled check box is checked.)</td>
</tr>
<tr>
<td>Note: This setting must be used with the Default Source Segment Loading setting found on the Setup&gt;Restoration:IntelliTeam SG&gt;External Loading screen in the IntelliLink Setup Software. Both settings must be enabled for the IntelliTeam system to calculate the proper available capacity of a given source.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: When using the Post Restoration Load Management feature and enabling the Restore to Max Capacity Plus Overload option, the Overload Permitted setpoint is added to the switch’s Maximum Capacity setpoint as the new maximum capacity the switch can carry. Therefore, careful consideration should be taken when using that option if there are switches in the system that have lower maximum capacity values than what is being used at the substation.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Post Restoration Load Management Timers</td>
<td>Post Restoration Load Management Timers</td>
<td>These timers allow users to configure the IntelliTeam SG system to allow temporary overloads during post-restoration load management (PRLM). They also add flexibility to the overall PRLM process in terms of when the load shedding events should occur during an overload condition. This feature is only available with IntelliTeam SG 6.1 firmware and later versions.</td>
</tr>
<tr>
<td>Overload Permitted (amps)</td>
<td>Overload Permitted (amps)</td>
<td>This value is added to the Maximum Source Capacity threshold and becomes the new maximum load threshold that, when exceeded, requires immediate load shedding using post-restoration load management when the Time Overload Permitted timer expires.</td>
</tr>
<tr>
<td>Time Overload Permitted (min)</td>
<td>Time Overload Permitted (min)</td>
<td>This is the amount of time that an Overload Permitted condition is allowed to exist before shedding load to the Maximum Source Capacity threshold.</td>
</tr>
</tbody>
</table>
Tools and Features

Substation Team Attributes Tab

Overload Qualification Time (sec)

This is the amount of time an overload must be present to be considered qualified and Post-Restoration Load Management logic will begin.

Enable/Disable Restore to Max Capacity Plus Overload

Enables/disables restoring load up to the source maximum capacity plus the overload permitted during an IntelliTeam SG system restoration event. (When this check box is checked, this option is enabled and will restore load up to the source maximum capacity plus the overload permitted.)

Substation Team ID

Automatically populated by running the Validate function; provides a unique designation used by IntelliTeam SG system to identify each sub team.

IntelliTeam Options Enabled

User Setting—The default is ITSG. This setting must be set to the same setting that all of the team members are set to in the Team Attributes tab.

Disabled

All IntelliTeam functionality is turned off and disabled.

ITII

Puts the selected device in IntelliTeam II Compatibility mode (This setting is used when setting up a device to operate in an IntelliTeam II system with 5800 Series Automatic Switch Controls. All devices in a given circuit must be using IntelliTeam II Compatibility mode for this option to be used.)

Note 1: IntelliTeam Designer cannot push settings to a 5800 Series Automatic Switch Control. These controls need to be configured using the IntelliLink Setup Software. Also, this mode is not compatible with distributed generation and cannot be used when there are distributed generation devices on the circuit.

Note 2: To configure the system in IntelliTeam II Compatibility mode without runners using IntelliTeam Designer version 7.1.x - 7.3.x, (i.e. legacy IntelliTeam II mode with only coach traffic), the Clear Feedernets button in the communication manager must be clicked after the netlists have been successfully pushed to all of the team devices. To verify that a system is in this mode of operation, go to the Historic Log in the IntelliLink Setup Software and verify ITII mode is in the Active state. Otherwise, this mode uses runners and will increase traffic on the communications system unnecessarily. Refer to S&C Instruction Sheet 1044-577, “IntelliTeam® Designer: IntelliTeam® II Setup and Configuration,” for more information about IntelliTeam II Compatibility mode of operation.
Note 3: To configure the system in IntelliTeam II mode using IntelliLink Setup Software setpoint files, all devices need to be configured with the IntelliTeam Options Enabled setting in ITII mode. Refer to S&C Instruction Sheet 1044-577, “IntelliTeam Designer: IntelliTeam II Setup and Configuration,” for more information.

ITSG
Puts the selected device in IntelliTeam SG mode, with Rapid Self-Healing mode turned off (This mode uses IntelliTeam II style restoration and has both runners and coaches being used.)

Note: This mode is not compatible with 5800 Series Automatic Switch Controls but it is compatible with distributed generation devices on the circuit.

ITSGwRapidSelfHealing
Puts the selected device in IntelliTeam SG mode with Rapid Self-Healing mode turned on (Rapid self-healing must be turned on to enable post-restoration load management.)

Note: This mode is compatible with distributed generation devices on the circuit.

ITSGwPLIsolation
Puts the selected device in IntelliTeam SG mode with Phase-Loss Isolation mode enabled (Phase-loss isolation looks for a loss of phase voltage and will then isolate the effected teams and restore around them as necessary. This option can only be used with devices that support three-phase voltage sensing.)

Note: This mode is compatible with distributed generation devices on the circuit.

ITSGwRapidSelfHealingAndPLIsolation
Puts the selected device in IntelliTeam SG mode with Rapid Self-Healing and Phase Loss Isolation modes turned on (This option can only be used with devices that support three-phase voltage sensing. Refer to S&C Instruction Sheet 1044-575, “IntelliTeam® Designer: Phase-Loss Isolation,” for more information on phase-loss isolation.)

Note: This mode is compatible with distributed generation devices on the circuit.
Distributed Generation Attributes Tab

Distributed Generation ID

This is automatically populated by running the Validate command. It provides a unique designation used by the IntelliTeam SG system to identify each distributed generation team. See Figure 33.

Figure 33. The Distributed Generation Attributes Tab.

First Device In Sub

Checked (True)

The IntelliNode module is installed on the substation breaker, or an IntelliRupter fault interrupter is used as the substation breaker.

Unchecked (False)

The first IntelliTeam device is outside the substation.

Default Load Contribution

This is automatically populated by running the Validate command. It provides a unique designation used by the IntelliTeam SG system to identify each distributed generation team. See Figure 33.

This setting should only be used when no real-time loading data are available from a distributed generation device. When set to a non-zero value, the IntelliTeam system uses this as the amount of current flowing from the distributed generation device into the distributed generation team. When set to zero (the default), the IntelliTeam system uses loading polled by the IntelliNode/Info-Only module from the distributed generation device as the current it’s contributing to the distributed generation team. But if a normal IntelliTeam system device is teamed with the distributed generation device, it will assume there is zero amps flowing into the distributed generation team from the distributed generation device when this value is set to zero. The distributed generation team load will then be calculated by the IntelliTeam system device by using the current flow measured by that device. (Range: 0–1000 A; Default = 0, meaning this is disabled and not used by the IntelliTeam system.)

Note: If this value is set to a non-zero value, the IntelliTeam system will use this value to determine the amount of current flowing into the distributed generation team, even when a device teamed with the distributed generation device measures current coming from the distributed generation device. Therefore, this should only be used in cases where no real-time loading information is available from the distributed generation device when using an IntelliNode/Info-Only device.
**DG Reconnect Delay Timer**

This is the amount of time delay that occurs to reconnect the distributed generation device back to the grid, when the **Return to Normal** (RTN) process is complete. When this setpoint is a non-zero value and the **Transfer Trip Prohibit Restoration** (TTPR) mode on the device is enabled, after the normal source is returned and the circuit is otherwise in the normal configuration, the IntelliTeam system logic will start this timer. After the timer expires, the IntelliTeam system logic removes the **Transfer Trip Prohibit Restoration** (TTPR) mode on the device and will then close the device to bring the distributed generation device back online. (Range: 0-900 seconds; Default = 0 seconds, meaning the **Reconnect DG on Return to Normal** mode is disabled.)

**Note 1:** If for any reason the **DG Reconnect Delay Time** timer is aborted, the timer will not restart automatically and the distributed generation device must be manually put online.

**Note 2:** When an IntelliNode/Info-Only module is not directly associated with the distributed generation device, it is up to the distributed generation device’s own protection/control device (e.g. breaker, inverter, etc.) to reconnect the distributed generation device, because the IntelliTeam system has no control over the device or the reconnection process. However, it should be put online when good voltage, current, and frequency are seen by the distributed generation protection/control device. When the IntelliTeam system control is an IntelliNode/Info-Only module directly associated with the distributed generation device, if it was sent the initial **Transfer Trip** command it will control the reconnection process and issue a **Close** command to the distributed generation device’s protection/control device when the **DG Reconnect Delay Time** timer expires.

**Note 3:** See S&C Instruction Sheet 1044-578, “IntelliTeam® Designer: Distributed Generation Setup and Configuration,” for more information on how to setup and configure a circuit with DG devices.

**Note 4:** If a **Transfer Trip** command is programmed to be sent to a device on an alternate circuit, set the **DG Reconnect Delay Timer Time** setpoint to a value greater than 30 seconds. This should provide the IntelliTeam system enough time to close the tie point before the **DG Reconnect Delay** timer expires, which would allow the distributed generation device to reconnect prematurely.
Follow these steps to place sources:

**STEP 1.** Place the four sources using the **Add Source** button on the tool bar, and then click on the drawing area to place them.

**STEP 2.** Now put SRC 1 on the left and SRC 2, SRC 3, and SRC 4 on the right. Move the sources on the right so SRC 2 is on the top and SRC 4 is on the bottom. See Figure 34. Text color is automatically adjusted for the source box color.

**Note:** Use the **Repeat Insert** button to keep the Add Source tool active until all of the sources are placed. Remember to click the **Select Item** button to stop inserting more sources when the **Repeat Insert** button is selected.

**STEP 3.** Move SRC 4 to the lower right-hand corner of the drawing area and SRC 1 to left side. Then, select SRC 2, SRC 3, and SRC 4. See Figure 34 on page 57. Press and hold the <Ctrl> key while clicking on each object with the mouse cursor to select multiple devices at once.

**Note:** There are two ways to select multiple objects, but remember that the **Select Item** button has to be selected first. As shown in Figure 35 on page 57, place the mouse cursor to one corner of the area containing the objects, press the left mouse button, and drag the mouse cursor across the area. A screen will open when the mouse is dragged, indicating which devices are included in the selection. All of the objects in the screen will be selected after the left mouse button is released.

---

**Sources**

**Note 5:** See S&C Instruction Sheet 1044-579, “IntelliTeam® SG Automatic Restoration System: Remote Transfer Trip Setup and Configuration,” for more information about how to set up and configure devices to send Transfer Trip messages to remote devices.
STEP 4. When all of the objects have been selected, click on the Align Right tool to line up the sources with the farthest right source. Then, click the Space Vertically tool to evenly space the sources. See Figure 36.

STEP 5. Select SRC 1 and SRC 3. If SRC 1 is above SRC 3, as is the case in Figure 33, click on the Align Bottom tool. If SRC 1 is below SRC 3, click on the Align Top tool. This action will result in SRC 1 and SRC 3 being in line and vertically centered with relation to SRC 2 and SRC 4. See Figure 37.

Figure 35. Select SRC 2, SRC 3, and SRC 4.

Figure 36. Align and space the sources at the right.

Figure 37. Align SRC 1 and SRC 3.
Follow these steps to create wire connection points:

**STEP 1.** Click on the **Add Wire Connections** icon in the tool bar and then click on the drawing area as indicated in Figure 38.

**STEP 2.** Place four wire connection points approximately in line with SRC 1 and SRC 3.

**STEP 3.** Place one point above the second wire connection point from the left and the remaining three below the other three wire connection points in line with the centered sources.

![Figure 38. Add wire connection points.](image)

**STEP 4.** Make sure the four wire connection points in the center are all just above or just below the center of SRC 1 and SRC 3. Then, select to highlight the four wire connection points between SRC 1 and SRC 3.

**STEP 5.** In the screen shown in Figure 39, on page 59 all connection points are just above the center line. Depending on their relationship, use the Align Bottom tool or the Align Top tool to center the wire connection points on the two selected sources. This action aligns the source termination points with the wire connection points. Remember that the **Select Item** button must be clicked first before any alignment or spacing will occur.
STEP 6. In Figure 38 on page 58, the Align Bottom tool was used. Continue to use the spacing and alignment tools until the drawing looks like Figure 40.

**Note:** When the wire connection points and sources are aligned, adding wires is much easier.

Figure 40. Aligned points make the wire connection process easier.
Adding Wires

Follow these steps to add wires to the wire connection points:

**STEP 1.** Click the side bar pin to open the Component Explorer dialog box if it is not already open. Set the zoom to 150%. Use the scroll bars to position SRC 2, as shown in Figure 41.

*Note:* Zooming to enlarge makes wire placement easier.

![Figure 41](image)

**Figure 41.** Zoom in to make the wire connection process easier.

**STEP 2.** Click the Repeat Insert tool and the Add Wire tool. Now, when hovering the mouse cursor above a wire connection point or a source, the wire termination points will change, as shown in Figure 42.

![Figure 42](image)

**Figure 42.** Wire termination points shown with the Add Wire tool.
STEP 3. Select the left termination point shown in Figure 37, and drag a wire over to SRC 2. Drag the mouse cursor until the termination point on SRC 2 becomes visible. While holding the mouse cursor over the SRC 2 termination point, release the mouse button to make the connection. See Figure 43.

Figure 43. Release the mouse button over a termination point to make a connection.

Notice that after the mouse button is released the wire remains selected as indicated by the wire selection points. This allows grabbing the wire by a selection point and completing the connection if the wire has fallen short of the target. Click anywhere in the drawing field to deselect the wire before placing the next wire. See Figure 44.

Note: Before placing a new wire, make sure existing wires are deselected by clicking anywhere in the drawing space.

Note: Verify a wire is connected by grabbing a device and moving it. Just click on the undo icon right after the move to move it back to its original location.

Figure 44. White boxes on the wire show it is selected.
**STEP 4.** Continue placing wires until all of the wires are connected, as shown in Figure 45.

![Figure 45. Add wires to complete the circuit.](image)

**STEP 5.** Click on the Substations box followed by clicking on SRC 1 in the Component Explore dialog box to position the drawing, as shown in Figure 46.

![Figure 46. Automatic zoom to the selected substation.](image)
STEP 6. Click on the side bar pin to increase the drawing space and use the scroll bars to position the drawing, as indicated in Figure 47.

Figure 47. Click the side bar pin to increase drawing space.

STEP 7. Continue placing wires until the connections shown in Figure 48 are complete.

Figure 48. Add more wire connections.
STEP 8. Using the scroll bars, reposition the circuit (as shown in Figure 48 on page 63) and use the Add Wire Connection tool to add two wire connection points as indicated. Using the alignment and spacing tools, arrange the Wire Connection points to look something like Figure 49.

**Note:** Turning the grid off can make it easier to straighten wires.

![Figure 49. Adding two wire connection points and aligning them.](image)

STEP 9. Continue adding wires until the connections shown in Figure 50 are complete.

![Figure 50. Connect the new wire connection points.](image)
STEP 10. Set the zoom to 100% and use the scroll bars to position the circuit, as shown in Figure 51.

Figure 51. View the circuit at 100% zoom.

Adding Switches

Follow these steps to add switches to the circuit design:

STEP 1. Select the Repeat Insert and Add Switch tools to insert all of the switching devices shown in Figure 512

Note: If switches are misaligned, use the alignment tools to straighten the group of switches. Use the spacing tools to create equal spacing between switches. Also, if adding a switch that does not automatically merge to the wire, just click the Undo button to remove the switch.

Figure 52. Insert switching devices with Repeat Insert and Add Switch tools.
STEP 2. To draw a pad-mount or Vista® Underground Distribution Switchgear configuration, add the switch to the wire with the **Add 2 Switch** button to create the Switch 1 Switch 2 entry.

STEP 3. If there is a third manual switch, add it as a switch on the line and then use the **Exclude/Include** button to convert it to a non-team closed manual switch, or use the **Exclude/Include Open** button to convert it to a non-team open manual switch. See Figures 53 and 54.

**Note:** To swap the switch positions on a two-switch device, right click on the pad-mount drawing and select the **Swap Switch Positions** command, as shown in Figure 55 on page 66.

![Figure 53](image_url)  
**Figure 53.** Three-switch pad-mount configuration, with a normally closed non-team manual switch.

![Figure 54](image_url)  
**Figure 54.** Three-switch pad-mount configuration, with a normally open non-team manual switch.
Use the Repeat Insert and Toggle Switch Open/Close tools to set the normally open points, as shown in Figure 55.

**Note:** Use the Toggle Terminal tool at the right of the Toggle Switch Open/Close tool to change the location of the open points. Notice that this was done for all of the vertical switches in Figure 56.

**Figure 55.** Swapping switch positions on a two-switch device.

**Setting the Normal State**

Use the Repeat Insert and Toggle Switch Open/Close tools to set the normally open points, as shown in Figure 55.

**Note:** Use the Toggle Terminal tool at the right of the Toggle Switch Open/Close tool to change the location of the open points. Notice that this was done for all of the vertical switches in Figure 56.

**Figure 56.** Set the normally open points with Repeat Insert and Toggle Switch Open/Close tools.
Validating

Follow these steps to validate the circuit layout:

STEP 1. After completing the circuit layout, click on the Validate tool, which will automatically assign team ID designations to each team and check the circuit for errors.

STEP 2. After validation, the line sections will be the same color as the source powering them. Click on the Configuration Display pin to open the Configuration screen, which contains the Validation tab. See Figures 57 and 58.

STEP 3. Save this screen work.

Figure 57. The Validate tool automatically assigns team ID designation to each team.

Figure 58. Validation makes line segments the same color as their source.
**Fragmented Circuit**

*Note:* If all sources are not connected to the circuit, validation will show the error: Fragmented Circuit. Fragmentation errors are defined in the Errors and Warnings dialog box. See Figure 59 for a fragmented circuit example.

![Fragmented Circuit](image)

**Figure 59.** A fragmented circuit fails validation because not all sources are connected to the circuit.

**Trace Connections**

If circuit validation shows a fragmented error, use the Trace Connections command to display source colors and identify where the disconnect is located. See Figure 57. If the wires connected to a source remain black, this indicates these wires are not connected to the other circuit.

When all sources are connected to the circuit, the Trace Connections command will display all wires the same color as their source. See Figure 60.

![Trace Connections](image)

**Figure 60.** The Validate tool will color wires the same color as their source.
Follow these steps to enter the RTU addresses and serial numbers:

**STEP 1.** If all goes well, the only validation warnings at this time are the missing RTU addresses and serial number assignments. Click on the **Device Attributes** tab and select a device.

**STEP 2.** Enter an RTU address in the configuration editor at the right.

**STEP 3.** Select the serial number for the device.

**STEP 4.** When all of the missing RTU addresses and serial numbers have been entered, click on the **Validation** button again; this will delete the associated warnings. See Figure 61.

![Figure 61. Enter RTU addresses in the configuration editor.](Image)

Follow these steps to enter or revise device attributes:

**STEP 1.** On the Netlist Configuration dialog box, select the **Device Attributes** tab. See Figure 60.

**STEP 2.** In the Device Attribute Editor, select the item to edit in the netlist configuration. Select RTU Address, IP Address, Serial Number, or CEC Allowed. For this example, we will edit the IP address.

**STEP 3.** Manually enter each entry for the IP address.
STEP 4. The multiple attributes that contain the **Multi-Update** button also can be automatically updated. A **Multi-Update** button with a “+” indicates the multi-update function will increment the values. For example, a multi-update applied to the RTU attribute will set the devices’ RTU values to 1, 2, 3, … while a multi-update to the CEC Allowed attribute will set all selected devices to **CEC Allowed** mode. See the following steps about invoking multi-updates. See Figure 62.

![Device Attribute](image)

**Figure 62.** Multi-Update buttons on the Device Attribute dialog box.

STEP 5. Highlight the range of devices to automatically enter a value for. Click on the first device, and shift-click the last device to establish a range. See Figure 63. To enter a group of individual devices, control-click the devices or use control-A to select all lines. See Figure 64 on page 72.

![Infrarad Design](image)

**Figure 63.** Shift click to highlight a range of devices.
STEP 6. Enter the IP address to be configured sequentially. See Figure 65.

STEP 7. Toggle the Multi Update button next to the IP attribute. See Figure 66.
STEP 8. Click on the button with the check at the top right to apply the change. The Summary of Changes dialog box will open. See Figure 67. Click on the Yes button to apply the changes.

![Figure 67. New values entered in the Summary of Changes dialog box.](image)

STEP 9. This will update the devices with incrementing IP addresses (i.e. 192.168.200.1, 192.168.200.2, etc.). See Figure 68.

![Figure 68. IP addresses have been updated.](image)
STEP 10. Alternatively, use the Multi Update dialog box to make multiple updates. Select the desired attributes to edit, and click on the **Multi Update Dialog Box** button. Only attributes with Multi Updateable values are visible. See Figures 69 and 70.

![Figure 69. The Multi Update buttons on the Device Attribute dialog box.](image1)

![Figure 70. The Multi Update dialog box.](image2)
STEP 11. Toggle the Serial Number button and select a starting serial number. Also toggle the CEC Allowed button and check the box for CEC Allowed. See Figure 71.

![Figure 71. CEC Allowed value is selected.](image)

STEP 12. Click on the Apply button to immediately apply the Multi Update values and keep the Multi Update dialog box open, or click on the OK button to apply and close the Multi Update dialog box. The changes will now be entered in Netlist Configuration. See Figure 72.

![Figure 72. Netlist Configuration shows the completed changes.](image)
In the example in Figure 73, there is an IntelliNode Interface Module at each source, and DS 15 needs to be added to SRC 4.

Notice there are teams designated by “T#,” and sub-teams “ST#” that indicate a section of line between a source and the first IntelliTeam SG system device.

Figure 73. Team designations are shown on the circuit.
Device Attributes

Follow these steps to revise device attributes and revalidate to update the team designations:

**STEP 1.** Using the Component Explorer dialog box, one by one select DS 2, DS 4, DS 7, and DS 15. As each switch is selected, use the Visual Properties dialog box to change the **Device Type** setting from “IntelliRupter” to “IntelliNode.” See Figure 74.

![Figure 74. The Component Explorer and Visual Properties dialog boxes.](image)

**STEP 2.** Use the **Device Attributes** tab found in the Netlist Configuration dialog box to configure the IP address. See Figure 75.

![Figure 75. The Device Attribute dialog box edits the IP address.](image)
STEP 3. Click on the **Team Attributes** tab to open the Team Attribute dialog box to the right. See Figure 76.

(a) Configure the **Line Segment Limit** setpoint.
(b) Configure the **Contracts Required** setpoint to the **On** or **Off** mode.
(c) Configure the **Return to Normal Time** setpoint.
(d) Configure the **Prohibit Restoration Time** setpoint.

For more information on team attributes, please see the “Team Attributes Tab” section on page 42. For more information on the operation of the IntelliTeam SG system, review S&C Data Bulletin 1044-92, “IntelliTeam® SG Automatic Restoration System: Dispatchers Guide.”

![Figure 76. The Team Attributes tab is used for editing team parameters.](image)

STEP 4. Click on the **Team Member Attributes** tab below the configuration dialog box and the Team Member Attribute dialog box will open to the right. Highlight the Team ID entry for the team to configure. See Figure 77.

(a) Configure the **Maximum Capacity** setpoint.
(b) Configure the **Return to Normal Mode** setpoint.

For more information on team member attributes, please see the “Team Member Attributes Tab” section on page 47. For more information on the operation of the IntelliTeam SG system, review S&C Data Bulletin 1044-92, “IntelliTeam® SG Automatic Restoration System: Dispatchers Guide.”

![Figure 77. The Team Member Attributes tab is used for editing team member settings.](image)
STEP 5. Click on the **Substation Attributes** tab below the configuration dialog box and the Substation Attribute dialog box will open. Highlight the Substation ID entry for the source to configure. See Figure 78.

(a) Check the Set Max Capacity as Disable checkbox to disable the use of this source, if desired. To keep the source enabled, do not check this checkbox.

(b) Configure the **Maximum Capacity** setpoint.

(c) Configure the **Overload Permitted** setpoint for the amount this source can be overloaded, if desired. A value of “0” will not allow an overload to occur.

(d) Configure the **Time Overload Permitted** setpoint for the allowed duration of the overload condition, if desired. A value of “0” will not allow an overload to occur.

(e) Configure the **Overload Qualification Time** setpoint for the time required to qualify the overload condition. This setpoint is only used if the **Overload Permitted** setpoint is in the **Enabled** state.

(f) Configure the **Enable/Disable Restore to Max Capacity Plus Overload** setpoint, which allows an overload condition during a restoration event.

These attributes need to be configured per the operating needs of the IntelliTeam system and should be reviewed by a qualified S&C application engineer or field service representative before being applied to a system. For more information on substation attributes, see the “Substation Team Attributes Tab” section on page 52.

![Figure 78. The Substation Attributes tab is used for editing source parameters.](image)

STEP 6. Click on the **Distributed Generation Attributes** tab below the configuration dialog box and the Distributed Generation Attribute dialog box will open. Highlight the Distributed Generation ID entry for the DG device to configure. See Figure 79 on page 79.

(a) Configure the **Default Load Contribution** setpoint if needed. Otherwise, leave it at the default of 0, meaning it is disabled and not used.

(b) Configure the **DG Reconnect Delay Timer** setpoint if IntelliTeam should attempt to reconnect the DG device after the IntelliTeam system has completed the Return to Normal process.

For more information on the Distributed Generation attributes, see the “Distributed Generation Attributes Tab” section on page 54.
STEP 7. Run the **Validate** command to display any new errors. Correct the errors and save the work. The IntelliTeam SG system is now configured and ready to deploy the IntelliTeam SG system device attributes. See Figure 80.

Customize the circuit with image files, user-defined text, and by drawing objects. Show or hide wire connections by clicking on the **Show Wire Connections** option in the **Option** menu. None of these changes require validation to be re-run because they are visual changes only and do not affect the IntelliTeam system circuit or settings.


**Figure 79.** The Distributed Generation Attributes tab is used for configuring DG device parameters.

**Figure 80.** When a validation is successful, the circuit is ready to deploy.
Overview

The NetList is a system configuration database for an IntelliTeam SG Automatic Restoration System. It includes information about team member connectivity, load constraints, device function, and enabled features.

Because the IntelliTeam SG system is highly scalable and can operate extremely large systems, the netlist is divided into subsets called FeederNets. A FeederNet has data for the group of all switches fed by a single source. Because power could flow in either direction through a normally open switch when it’s closed, FeederNets overlap at open points, and each open point will be listed in the two adjacent FeederNets.

Because the system is divided into FeederNets, only the affected FeederNets must be updated when making a change. If a normally closed switch is inserted in a series of normally closed switches, only one FeederNet and its associated field devices will require updating. Similarly, if an open point between two FeederNets is moved, only those FeederNets and the associated field devices require the update.

Typically, each FeederNet has one entry point device, and that is the switch closest to the substation. The only exception is the rare case where there are multiple open substation switches in a FeederNet and no closed switches; in that case, every one of those open substation switches is an entry point device.

With a closed-loop system, only one of the two sources is listed in the FeederNet when it is configured. For firmware versions 7.1 and earlier, when the IntelliTeam SG system begins to operate in a closed loop, it dynamically updates switch functions based on load flow and determines the approximate center point, which is the logical place to sectionalize during an event. For more information on closed loops with the IntelliTeam SG system using firmware versions 7.1 and earlier, refer to S&C Instruction Sheet 1044-574, “IntelliTeam® Designer: Closed-Loop Operation.”

When running firmware version 7.3 and later, the IntelliTeam SG system will use the configured center point switch to break the closed loop when a sectionalizing event occurs. For more information on closed loops with the IntelliTeam SG system running firmware version 7.3 and later, refer to S&C Instruction Sheet 1044-580, “IntelliTeam® Designer: Closed Loop Operation.”

Updating IntelliTeam SG Software

Versions 2.0.0.0 and later of IntelliTeam Designer have license-management activation. See the “License Management” section on page 6 for more information. To use the latest IntelliTeam SG system features, update both the software in the field devices and the license information in the netlist. Follow these steps to update the software:


STEP 2. Open the existing netlist configuration one-line diagram in IntelliTeam Designer and update the serial number fields.

STEP 3. Click on the Validate button. Validation creates new FeederNets and enables the new IntelliTeam features in the new software. Once this is done, follow the procedure shown in the “Configuring Field Devices” section on page 82 to update the field devices.
Configuring Field Devices

Follow these steps to configure the field devices:

**STEP 1.** Set IntelliTeam Designer to the **Draw** mode (the default when IntelliTeam Designer opens).

**STEP 2.** Open the validated circuit, File>Open or File>Recent Files, if not already open.

**STEP 3.** Click on the **Communicate to Devices** icon, which opens the **Communication Manager** screen. See Figure 81 and Figure 82 on page 83.

**STEP 4.** Follow the procedure described in the following sections to continue with field device configuration.

![Figure 81. The Communicate to Devices icon.](image)

Communications Manager

To push the IntelliTeam system settings to S&C controls, the settings must be propagated to an entry point device within the FeederNet. This is accomplished using the communication manager. See Figure 82 on page 83. The communication manager is divided into four tab sections titled **Entry Point Device Configuration**, **Device Configuration Status**, **Operational Log**, and **FeederNet Status**. There is also a toolbar that contains various tools to facilitate and monitor the process of pushing the settings to the controls. These are explained in detail in the “Communications Tools” section on page 83.
Communications Tools

Check

The Check button verifies the FeederNet entry point devices have the same Node ID and CRC, and it checks communications between the IntelliTeam Designer software and the entry point devices. This creates a summary report of communication check success or failure for all devices.

For versions 7.5 and later, this button also checks the firmware each device is running and sets the appropriate Netlist propagation version to use.

Figure 82. The Communications Manager>Entry Point Device Configuration screen.
**Note:** If devices are running different firmware versions, the propagation version cannot be set and the **Push** function will remain disabled until they are all running the same firmware version and the appropriate propagation version can be set.

**Note:** The **Prohibit Restoration** mode must be cleared from a device being removed from an IntelliTeam SG system before pushing a new Netlist to avoid issues.

**Push**
The **Push** button starts pushing the netlist information to all enabled FeederNets. Check the Status column in the Device Configuration dialog box, and the state will change from **Unknown** to **Delivered** to **Accept** if everything goes well.

**Clear**
The **Clear** button clears all netlists and disables runners. This button must only be used when configuring IntelliTeam II system circuits. It is not required to clear netlists before a **Push** command because that is now part of the push process itself. Refer to S&C Instruction Sheet 1044-577, “IntelliTeam Designer: IntelliTeam® II Setup and Configuration,” for more information on **IntelliTeam II** mode of operation.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Clear</strong> button disables all IntelliTeam SG system features and puts the teams in <strong>IntelliTeam II</strong> mode only.</td>
</tr>
</tbody>
</table>

**Monitor/Stop**
The **Monitor/Stop** button checks status of the FeederNets and devices in the **Device Configuration** tab. Use this function to monitor the status of the netlist push and determine whether the actual FeederNets that the device has are the expected FeederNets.

**Note:** The log entries in the Operation Log will update with this status information when the **Monitor** function is enabled. However, it may take several minutes after the log entry that states “Push is complete” to actually update the secondary FeederNets in devices.

**Show/Hide Communication Settings**
The **Show/Hide Communications Settings** button opens more data in the **Entry Point Device Configuration** and **Device Configuration** tabs.

**FMS Export**
The **FMS Export** button exports IntelliTeam Designer data to the IntelliTeam Feeder Management System (FMS) software.

**Copy**
The **Copy** button copies the Operational Log information to a clipboard for use in other applications.
**Auto Scroll**
The *Auto Scroll* button will continue or stop Operational Log scrolling. Auto scrolling can also be activated by selecting/scrolling to the last item in the log, and it can be deactivated by selecting/scrolling to a line item other than the last item in the log. However, auto scrolling will not become enabled by checking this box manually. Auto scrolling will become enabled automatically when a **Push** or **Check** operation is executed.

**Propagation Status**
The *Propagation Status* field shows the progress of the netlist propagation to all the enabled FeederNets.

**Last Update Status**
The *Last Update Status* field shows a time-stamped update of the last action being performed.

**Summary Report**
The *Summary Report* field presents information about each FeederNet propagation, whether it was successful, pushed, retried, or failed. There is also a summary report for checking communications status.

**Quick Help**
The Quick Help dialog box displays FeederNet Configuration help text.

**Dialog Box Tab**
The dialog box tab for the communication manager (see Figure 83) has the following options available:
- **Float**—Allows the dialog box to float within the IntelliTeam Designer application
- **Dock**—Docks the dialog box in the Tree View area
- **Dock as Tabbed Document**—Docks the dialog box in the drawing area
- **Auto Hide**—Hides the dialog box
- **Close**—Closes the dialog box and closes the communication manager

![Dialog Box Tab](image)

**Figure 83. The Communication Manager Dialog box tab.**
Entry Point Device Configuration Tab

This tab is used for communication setup to entry point devices for the netlist Push process. See Figure 80 on page 81.

Entry Point Device
Select the entry point device to be used by the FeederNet. The default is the first device on the feeder that is either the source/sub or tie/sub device.

Note: The entry point device reverts to the default selection when the communication manager is closed.

Connection Type
Select the connection type used to connect to the entry point device. Options are: None, Serial, IP, LinkStart (WiFi), ICPSerial, ICPIP, and WAN.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The LinkStart connection type connects to only one device at a time. To propagate the FeederNet data, push a FeederNet to each device on the circuit one at a time. A LinkStart connection type should not be used for circuits with more than two devices.</td>
</tr>
</tbody>
</table>

DNP Address
This is the DNP address of the entry point device. This value is programmed into the configuration based on the information configured in the Device Attributes tab. The Use Self option, when checked, uses the devices DNP self address instead of the programmed DNP address.

Serial Port
Select the serial port used to connect to a control when the connection type is specified for Serial connections. Options are COM1-COM250.

Retry Time (Seconds)
This is the number of seconds each retry will be performed when a netlist push to an entry point device is not successful.

Retry Count
This is the number of retries that will be performed when a netlist push to an entry point device is not successful.

Baud Rate
This is the baud rate used for serial connections. Options are: BR1200, BR2400, BR4800, BR9600, BR19200, BR38400, and BR57600.

Our RTU
This is the RTU address of the device being used to connect to the entry point device. Use the default of 65431 unless otherwise instructed.
**User Name**
This is the username used to connect to the entry point device.

**Password**
This is the password used to connect to the entry point device.

**Options**

**Parameters Common to All Entry Points**
The Parameters Common to All Entry Points button sets the communication parameters common to all entry point devices on the FeederNets. See Figure 84 on page 88.

**Note:** Passwords are not displayed on the main configuration area but are still saved for that session. When the communication manager is closed, the password must be re-entered.

**Disable/Enable All FeederNets**
The Disable/Enable All FeederNets button enables or disables the netlist push to all FeederNets.

**Note:** Individual FeederNets can be enabled or disabled by clicking on the Enable check box next to each FeederNet.

**Retrieve Data from All Devices**
When checked, the Retrieve Data from All Devices option will check communications for all disabled and enabled FeederNets when the Check communications function is executed.

**Import Comm Setup File**
The Import Comm Setup File button allows a user to select a communications setup file from their PC to pre-load the communications parameters into the Entry Point Device Configuration tab.

**Export Comm Setup File**
The Export Comm Setup File button allows a user to save the existing communications parameters they have programmed to a communication setup file that can be later imported using the Import Comm Setup File option.
Device Configuration Tab

The Device Configuration Tab screen displays the progress of the current netlist propagation to the FeederNet devices. Normally open devices are shown twice in the device list because they are associated with two FeederNets. See Figure 84.

![Device Configuration Tab Screen](image)

**Figure 84.** The Device Configuration Tab screen.

*Filter*

The Filter tab filters the information shown in the Device Configuration tab. Options are:

**Show All**—Displays all information during the netlist push process

**Show Errors**—Displays only errors seen during the netlist push process

**Show Completed**—Displays the FeederNets that have had a successful push

**Show In Progress**—Displays the FeederNets that are still in progress of getting their netlist data

*Options*

The “Options” section configures communication parameters:
System Configuration

Parameters Common to All Entry Points
The Parameters Common to All Entry Points button sets all the communication parameters common to all entry point devices on the FeederNets.

Note: Passwords are not displayed on the main configuration area but are still saved for that session. When the communication manager is closed, the password must be re-entered.

Max Secondary Acceptance Iterations
The Max Secondary Acceptance Iterations control sets the number of attempts the entry point device will propagate the secondary FeederNet information to devices when the initial propagation is not successful. (Range: 20-100)

Transactions
The “Transactions” section selects netlist Push operation options.

Push netlists into Enabled FeederNets
The Push netlists into Enabled FeederNets button starts the netlist propagation (push) process to the entry point devices when all communication parameters have been configured. Clicking on the Halt button after a Push operation has started will stop the process. To resume the Push operation, click on the Push button.

Monitor FeederNet Configuration Status
The Monitor FeederNet Configuration Status button starts the monitoring process, which shows updates on the Device Configuration screen as the netlists are propagated to the individual FeederNets.
Operational Log Tab

The Operational Log Tab screen displays communication system operation and logs all the relevant information during the push process. See Figure 85.

![Operational Log Tab Screen](image)

Figure 85. The Operational Log Tab screen.

**Verbose Logging**

When checked, the Verbose Logging tab turns on verbose logging in the Operations Log. This feature should only be used when troubleshooting because it adds additional overhead and processing to the push process and could cause it to slow down.

**Auto Scroll**

When checked, the Auto Scroll tab will continue or stop Operational Log scrolling. Auto scrolling can also be activated by selecting/scrolling to the last item in the log, and it can be deactivated by selecting/scrolling to a line item other than the last item in the log. However, auto scrolling will not become enabled by checking this box manually.

**Copy Contents to Clipboard**

The Copy Contents to Clipboard button copies the Operational Log information to the clipboard for use in other applications.

**Clear Log**

The Clear Log button clears the information shown in the present Operations log.
**FeederNet Status Tab**

The *FeederNet Status Tab* screen displays more detailed information about the progress of the present netlist propagation. See Figure 84 on page 87.

**Filter**

The Filter button filters the information shown in the *FeederNet Status* tab. Options are:

- **Show All**—Displays all information during the netlist Push process
- **Show Errors**—Displays only errors that are seen during the netlist Push process
- **Show Completed**—Displays the FeederNets that have had a successful push
- **Show In Progress**—Displays the FeederNets that are still in progress of getting their netlist data.

**Polling Interval**

The *Polling Interval* setpoint adjusts the monitoring and polling frequency of the FeederNet Status log. (Range: 5.00 to 15.00 milliseconds)

*Note:* Using a fast polling rate could tax the processor on the computer that is being used to perform the push.

**HTML**

The *HTML* button dumps the FeederNet Status log to an HTML file.

**Clear**

The *Clear* button clears the information shown in the FeederNet Status log.

**Propagation**

This section describes the process for propagating the IntelliTeam SG system settings to the S&C controls. It is shown as the general workflow used to perform propagation and general troubleshooting steps that may be required to analyze propagation problems. For configuring devices using the communication manager for *IntelliTeam II* mode, see S&C Instruction Sheet 1044-577, “IntelliTeam® Designer: *IntelliTeam® II Automatic Restoration System Setup and Configuration.*”

**Setting up Communications**

Follow these steps to configure communication parameters:

**STEP 1.** In the *Entry Point Device Configuration* tab, select a FeederNet from the list by clicking it. In the majority of cases, the entry point device for the FeederNet is automatically selected in the Entry Point Device pull-down box. For the rare case when there are multiple entry point devices (all switches in the FeederNet are open substation switches), different entry point devices may be selected.

**STEP 2.** Make a selection from the *Connection Type* pull-down menu and fill in the details required for that connection type.
The LinkStart connection type connects to only one device at a time. To propagate the FeederNet data, push a FeederNet to each device on the circuit one at a time. A LinkStart connection type should not be used for circuits with more than two devices. If a FeederNet contains more than one device, propagating and monitoring the FeederNet information successfully requires that the PC running IntelliTeam Designer has an Ethernet connection to the entry point device that allows communication to all other devices on the FeederNet.

STEP 3. If the device type is IntelliRupter PulseCloser Fault Interrupter, a 6800 Automatic Switch Control with security, or an IntelliNode Interface Module (v6.3 or later), a username and password must be entered.

**Note:** Once entered, a username will be remembered. However, the password is not saved and must be re-entered each time the communication manager is opened. Also, DNP addresses and IP addresses are loaded from the netlist and cannot be modified by the communication manager. Make sure all address information is up-to-date before opening the configuration manager.

**Note:** Parameters shared by all devices can be entered on the Common Communication Parameters dialog box to expedite communications setting setup for all entry point devices. See Figure 83 on page 87. Open this by clicking the **Parameters Common to All Devices Set** button. Passwords will not be displayed on the main configuration area but are still saved for that session. If the communication manager is closed, the password must be re-entered. See Figure 86.

![Figure 86. The Common Communication Parameters dialog box.](image-url)
When the communication settings are configured for all entry point devices, the next step in the propagation process is to check the communications between the IntelliTeam Designer software and the entry point devices and to gather any existing netlist data from the devices. Follow these steps to check communication with the entry point devices:

**STEP 1.** Click the **Check** button to test communication and collect information about netlists presently loaded into the devices. When completed, a dialog box will show success or failure of the communication check.

**STEP 2.** Click the **Operational Log** tab to see a report of the communication test. A summary report is shown at the bottom. The log contents can be copied to the clipboard for future reference. See Figure 87.

Figure 87. The **Operational Log** screen showing a successful communications check.
Starting the netlist Propagation

To make sure an out-of-date netlist is not propagated when a field device is configured locally, a Propagate netlist Enable/Disable setting is provided in the IntelliLink Setup Software for software versions before 7.1.x. The 7.1.x version of software always has this setting enabled. Therefore, it is no longer required when using that version of software or later. See Figure 88.

Figure 88. The Propagate netlist option in the IntelliLink Setup Software tool.

Follow these steps to propagate the netlists:

**STEP 1.** For software versions before 7.1.x, confirm that all field devices have the Propagate netlist function in the Enabled mode before propagating a new FeederNet.

**STEP 2.** Select the FeederNets to be updated by checking one of the Enabled checkboxes or clicking on the Enable button next to the Disable/Enable All FeederNets option in the Entry Point Device Configuration tab. See Figure 89 on page 94.
STEP 3. For version 7.5 and later, click on the Check button to run a communications check, which will verify the version of firmware the devices are running, so the appropriate Netlist version is configured on the devices.

**Note:** All devices must be running the same firmware version before a Push will be allowed.

**Note:** The Push button will change to a Halt button when clicked. Clicking on the Halt button will abort FeederNet transmission, and this is not recommended unless there are errors occurring during the push process.

STEP 4. Verify the actual switch states in the field match the expected switch states in IntelliTeam Designer before proceeding. Inconsistencies could lead to unexpected behavior. A dialog box will open: “Do you wish to push the enabled FeederNets? Yes or No?” Yes will proceed with the Push, No will cancel the Push. See Figure 90 on page 95.
System Configuration

It usually takes a couple of minutes to transmit one FeederNet. So, if there are several enabled FeederNets, the transmission may take some time to complete. Also, when the FeederNet propagation has completed (whether successful or unsuccessful) a message box under each progress bar will summarize the status, and the Operational Log will contain detailed information about the transmission.

**Note:** The communication manager automatically hides the other tabs and switches to the **FeederNet Status** tab when propagation starts. However, during propagation, all the other tabs may be used. The actual FeederNet information will also continue to update on the other tabs as the IntelliTeam Designer software retrieves feedback from the devices.

**Note:** When a Push operation is started, a second push must not be attempted until the configuration timer expires. This timer is configured by the **Comm Check Runner Timeout** setpoint located on the **Setup>Restoration>IntelliTeam SG>Communications** screen. The default value for this setting is two minutes. See Figure 92 on page 96.
Enabling Only Changed FeederNets

If updating a system to change IntelliTeam settings, add, remove, rewire devices or substations, or change the normally open point, push the new netlist to the changed FeederNets. If unsure whether a FeederNet requires updating, after the communication check has been completed, determine it from the table in the Entry Point Device Configuration tab. FeederNets out-of-date with data in their Entry Point Device will be shown in red, while FederNets that match data in their entry point device will be shown in green. Generally, push the FeederNets shown in red.

Further analyze the FeederNet data in the devices by studying the FeederNets in Device column in the Entry Point Device Configuration tab. It will list all FeederNets (using ID/CRC pairs as FeederNet identifiers) present in the entry point device. A cyclic redundancy check (CRC) is run on each FeederNet after validation to create the unique CRC number for each FeederNet. For the device to be fully up to date, that list should include the FeederNet(s) that the device is a part of and all the adjacent FeederNets. See Figures 93 and 94 on page 97 for examples.

Follow these steps to perform a Push operation to only the changed FeederNets:

**STEP 1.** Click on the Check button to check the FeederNets currently loaded in the entry point devices. See Figure 89 on page 94 as an example of this output.

**STEP 2.** Click on the Disable button next to “Disable/Enable All FeederNets” in the Entry Point Device Configuration tab, and then check the box under the Enabled column in the FeederNet table for the FeederNets that require a new push to be performed.

Figure 92. Entry point devices with out-of-date FeederNets shown in red.
STEP 3. Check the **Device Configuration** tab to see the list of the FeederNets that have been enabled for the **Push** operation. See Figure 95 as an example.

**Figure 95.** The FeederNets that will be pushed.

STEP 4. Click on the **Push** button to begin the propagation process and push the netlist data into enabled FeederNets.

**Note:** The **Push** button will change to a **Halt** button when clicked on. Clicking on the **Halt** button will abort FeederNet transmission, and this is not recommended unless there are errors occurring during the push process.

The **FeederNet Status** tab will now display the status of the push in real time, and the **Percent Complete** indicator will indicate progress of the entire update. In addition, the progress bars and LEDs on the left will indicate progress of each FeederNet push. When a successful push has been completed, all the LEDs will be green and the status will show as being completed. See Figure 95.
Monitoring and Validating a netlist Push

The table in the Device Configuration tab is maintained in real time during the propagation. It contains one entry per device per FeederNet, so the tie switches will be listed twice because they are each associated with two FeederNets. The table contents will only list devices in the presently enabled FeederNets.

While the netlist propagates, the Status column in the table will update for each device as FeederNet information is received. When confirmation of an Active status is received, the value of the Status field in the Device Configuration tab will change from the black, “Unknown,” to green, “Accept,” as shown in Figure 96.

When there are no connectivity changes involved, the blue Delivered state may be entered temporarily. The Status field can also be updated at any time by running the Monitor FeederNet Configuration Status process. To begin the process, click on the Monitor button, which changes to a Stop button while the process is running.

The Status field will also indicate whether there are issues detected. When a new FeederNet has not been accepted within the allowed time (a communication problem), the status indication will change to red and the Status field will display a Timeout condition. If there are issues where the actual FeederNet information does not match the expected FeederNet information for the secondary FeederNets, the row will be highlighted yellow.

Note: Before IntelliTeam Designer can enter the Ready state, an Accept status is required for all FeederNets. Achieving the Ready state may take several minutes after all the FeederNets have been accepted. See Figure 96.

![Figure 96. The FeederNet Device Status Accept indication.](image)

IntelliTeam Designer also checks the switch state of each member before the IntelliTeam system goes into the Ready state. If a device is not in the proper state, the Ready state will not be achieved for that device and the teams for which it is a member. The selected IntelliTeam Designer features can also affect the time it takes to enter the Ready state. Also, a Prohibit Restoration command or a manual switch operation will prevent the system from going into the Ready state after all the FeederNets have been accepted, so these will need to be cleared to get the teams into the Ready state.
Overview

Instant Replay enables the collection and replay of IntelliTeam SG data generated by an event or by a site automation test (SAT). The data collected by Instant Replay are a filtered subset of data in the field devices and include only the log entries directly relevant to an automatic restoration event.

The Instant Replay Log dialog box displays white and blue entries. See Figure 97. The white data are state points and have four categories that drive the graphic display changes as the event is played back. The categories are:

- Switch State
- Loss of Voltage
- Overcurrent
- SAT Active

Entries in the Description field describe the reason for the event. “Manual,” “IntelliTeam SG,” “SAT,” or “protection” are reasons for a switch-state change.

The blue data are event points and provide relevant information from the historic event log that is collected around the state points.

![Figure 97. Instant Replay log dialog box.](image-url)
Collecting Data

Open a circuit file to begin the data-collection process. Select File>Open and browse to the circuit to be displayed. See Figures 98 and 99.

**NOTICE**

The circuit used must correspond to the present state of the system. During the data-collection process, the target netlist (the netlist in the field devices) is going to be checked against the netlist associated with the open schematic. If the netlists do not match, an error will be generated, and the collection process will terminate.

Figure 98. Open a circuit file.

Figure 99. Open a Replay file.
Connection Setup

Click the **Communicate to Devices** icon to open the communication manager dialog box. See Figures 100 and 101. The next step is to communicate to the devices. Because the device connection details are retained, it is advisable to set up all the devices and uncheck the Enable Device check box, described later, to exclude devices that are not part of the event.

![Figure 100. The Communicate to Devices icon.](image)

Figure 100. The Communicate to Devices icon.

![Figure 101. Communication Manager dialog box.](image)

Figure 101. Communication Manager dialog box.
**Connection Setup for Data Collection**

**STEP 1.** Use the check boxes in the Manage Device List dialog box to select devices by feeder, or individually, for inclusion in the device list at the left of the Communication Manager dialog box.

**STEP 2.** When a feeder has been selected, click on the check boxes next to the devices that need to have the Instant Replay logs collected for that feeder. See Figure 102 as an example.

![Instant Replay Collection](image)

Figure 102. Device selection for Instant Replay collection.
STEP 3. When all required devices have been entered in the connection list, set the Connection settings for each device. Typically, the connection type will be IP.

Note: A Wi-Fi connection to an IntelliRupter fault interrupter requiring a LinkStart connection type is not a valid connection for log retrieval. A connection to a network or headend communication device capable of reaching all of the devices in the device list is required.

If the headend communication device uses a serial connection, set the serial port and baud rate. The only other required settings are the username and password if the device needs them. IntelliTeam Designer stores the username with the rest of the Device settings, but the password must be entered each time the communication manager is closed and re-opened.

Because the communication manager remembers the settings for each device, it is desirable to keep devices in the list once they have been entered. In the future, a device that does not need to be part of data collection can be disabled by unchecking the Enable: check box in the Communication settings. See Figure 103.
The **Setting Common Communication Parameters** fields are used for communication setup for the netlist **Push** process. See Figure 98 on page 101.

**Connection Type**
Select the connection type that is used to connect to the entry point device. Options are: None, Serial, IP, LinkStart (WiFi), ICPSerial, ICPIP, and WAN.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The LinkStart connection type connects to only one device at a time. To propagate the FeederNet data, push a FeederNet to each device on the circuit one at a time. A LinkStart connection type should not be used for circuits with more than two devices.</td>
</tr>
</tbody>
</table>

**DNP Address**
The **DNP Address** field shows the DNP address of the entry point device. This value is programmed into the configuration based on the information configured in the **Device Attributes** tab. The **Use Self** option, when checked, uses the devices DNP self address instead of the programmed DNP address.

**Serial Port**
Select the serial port used to connect to a control when the Connection Type is specified for serial connections. Options are COM1 through COM250.

**Retry Time (Seconds)**
The **Retry Time** field shows the number of seconds each retry will be performed when a netlist **Push** operation to an entry point device is not successful.

**Retry Count**
The **Retry Count** field shows the number of retries that will be performed when a netlist **Push** operation to an entry point device is not successful.

**Baud Rate**
The **Baud Rate** field shows the baud rate that is used for serial connections. Options are: BR1200, BR2400, BR4800, BR9600, BR19200, BR38400, and BR57600.

**Our RTU**
The **Our RTU** field shows the RTU address of the device being used to connect to the entry point device. Use the default of 65431 unless otherwise instructed.

**User Name**
The **User Name** field shows the username used to connect to the entry point device.

**Password**
The **Password** field shows the password used to connect to the entry point device.
Connection Check for Data Collection

When all devices are chosen and configured, verify the connections before attempting to download data from the field devices. Click the Check button shown in Figure 100. The communication manager will connect to each device unless the Enable: check box has been unchecked. A progress dialog box will appear and remain open as long as the connection test is processing. If an error is encountered, the communication check will be terminated and an error message will be shown at the Operational Log tab shown in Figure 104.

Retrieval Settings

Before retrieving the logs, follow these steps to set the Instant Replay retrieval options:

**STEP 1.** The Use PC Clock option can only be used with reasonably fast communication options such as SpeedNet™ Radios and only when round trip latency is three seconds or less for all devices. It is highly recommended that Instant Replay be used only on systems where all devices have GPS. Misleading results are possible when the PC Clock option is used because of communication system variability. The PC Clock option is intended as a backup to be used if GPS should become unavailable before a critical event. Under this circumstance, the PC Clock option will provide better results than an uncorrected field-device clock. When not using the PC Clock option, the timestamp is entered in UTC time. When using the PC Clock option, the timestamp is entered in local time.

**STEP 2.** Set the Approx. Event Time setpoint as close to the event start as possible, while leaving a pre-event field to ensure nothing is missed.

**STEP 3.** Set the Approx. Duration setpoint as short as possible, but allow sufficient time to ensure there is a small post-event field.

**STEP 4.** Checking the Read Memory Log Only check box will pull additional data from the .EVT log and include it in the Instant Replay log when the replay is executed. The additional data includes: EVT, DNP, and DAT logs from the .EVT file as well as the state and event points that are already included.

**STEP 5.** Checking the Recent Replays Only check box limits the number of event files checked and will speed up retrieval time. If the event occurred more than two hours before the retrieval attempt, this option should not be checked. See Figure 105 on page 107.
STEP 6. When the connection has been verified, click the Collect button, shown in Figure 106, to start data collection. The progress will be shown at the Operational Log tab and will continue to display the progress of collecting the log files until either an error is encountered or the process has been completed.

STEP 7. When collection is complete, the Save Instant Replay dialog box will automatically open. Enter a name for the file, and select an appropriate location to save the file.

**Timestamps**

Instant Replay relies on device timestamp precision. If the device clocks are not closely synchronized, Instant Replay presentations will not be accurate. While IntelliTeam Designer provides for manual synchronization of events coming from devices with clocks that are not synchronized, correction ability is limited.

Resynchronization is fairly easy if device clocks are out of synchronization by several minutes or less. If timestamps are unsynchronized by more than a few minutes, additional care must be taken to make sure the events being viewed from each device are associated with the same circuit disturbance and that all events associated with that circuit disturbance have been collected. If poor clock synchronization prevents correct Instant Replay generation, we suggest using Instant Replay via communication to live devices, as long as the clocks in the participating devices have run linearly (have not jumped around) since the occurrence of the circuit disturbance under investigation.

**Opening Instant Replay File**

After the replay file has been saved, it will be automatically imported into IntelliTeam Designer. To open a previously saved replay file, IntelliTeam Designer must be put in Instant Replay mode by clicking the Instant Replay Mode icon shown in Figure 107 on page 108.
The Instant Replay file can be opened two ways. Select File>Open Replay Log, as shown in Figure 108, and browse to the desired replay file. The Open button above the Instant Replay Log dialog box shown in Figure 109 can also be clicked to browse the replay file.

Figure 107. Instant Replay Mode icon.

Figure 108. Opening a Replay file.

Figure 109. Instant replay option buttons.

Playback Controls

- Play
- Pause
- Stop
- Move First (go to the beginning)
- Move Previous (back one log entry)
- Move Next (forward one log entry)
- Move Last (go to the end)

Figure 110. Instant replay playback buttons listed from left to right.
**Event Playback**

When an event file is open, playback can be accomplished in a number of ways. The event can be played by clicking on the **Play** icon. See Figure 110 on page 108.

Step through an event by clicking the **Move Previous** and **Move Next** icons or by double clicking a log entry in the Instant Replay Events dialog box, shown in Figure 110.

Checking the **State Points Only** check box, shown in Figure 111, filters out the events points, thereby reducing the display activity and the number of points seen in the Instant Replay Log dialog box.

The **Playback** screen, shown in Figure 111, contains the playback Comment box. Each time a new log entry is reached, the text field in the Comment box is updated with the **Description** field of the entry in the Instant Replay log. Arrows extending from the Comment box extend to each device affected by the log entry.

The black fields for the device indications and the black line segments indicate what has been affected by the voltage loss shown in the Comment box.

Checking the **Hide Comment** check box, shown in Figure 104, removes the Comment box and arrows from the display during playback.

![Figure 111. Playback screen with Comment box.](image-url)
Subsequence

If the exact time an event occurs is unknown, it may be necessary to use the maximum event time to capture a shorter event in the event log file. To break a log into shorter segments, click the **Subsequences** button shown in Figure 111 on page 109. The Select Subsequence dialog, shown in Figure 112, will open.

Enter a Sequence Association Time in the text box to set the maximum size of the subsequence. The larger the number, the fewer the number of sequences into which the file is divided. After the Association Time has been entered, click on the **Update Sequence** button and the available sequences will display by starting time in the selection field. To play a subsequence, select it and click on the **Use Selected** button. To remove sequencing and revert back to the original log file, click on the **Remove Sequencing** button.

**Figure 112. The Select Subsequence dialog box.**
The event file can be exported into an HTML file format by clicking on the HTML button shown in Figure 111 on page 109. A sample of the output file is shown in Figure 113.

**Figure 113. Sample HTML output.**

For more information about the Event Codes and Data columns in the HTML output, refer to:

- S&C Instruction Sheet 1043-551, “IntelliNode™ Interface Module: Troubleshooting”
- S&C Instruction Sheet 1045-550, “6800 Series Automatic Switch Controls: Troubleshooting”

<table>
<thead>
<tr>
<th>DEVICE</th>
<th>RTU</th>
<th>CAT</th>
<th>Event Code</th>
<th>Event Description</th>
<th>Timestamp</th>
<th>Data1</th>
<th>Data2</th>
<th>Data3</th>
<th>Data4</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1 W3 TI5A23</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:00:39:74</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P1 W3 TI5A23</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:00:32:01</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P4 W4 TI6A22</td>
<td>DMT</td>
<td>Do238</td>
<td>Not All Configured Trans Xfer Ready</td>
<td>01/15/2015 14:00:43:67</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P1 W4 TI5B32</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:00:43:70</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI3B25</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:00:58:47</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI3A23</td>
<td>UIM</td>
<td>Do238</td>
<td>Not All Configured Trans Xfer Ready</td>
<td>01/15/2015 14:00:54:80</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W4 TI5A24</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:00:47:34</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W4 TI8B27</td>
<td>DMT</td>
<td>Do238</td>
<td>Not All Configured Trans Xfer Ready</td>
<td>01/15/2015 14:01:06:38</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W2 TI126</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:18:82</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W2 TI128</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:32:96</td>
<td>0</td>
<td>9</td>
<td>10</td>
<td>NA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>DMT</td>
<td>Do238</td>
<td>Not All Configured Trans Xfer Ready</td>
<td>01/15/2015 14:01:33:00</td>
<td>0</td>
<td>9</td>
<td>10</td>
<td>NA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>DMT</td>
<td>Do238</td>
<td>Not All Configured Trans Xfer Ready</td>
<td>01/15/2015 14:01:33:96</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:35:97</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:42:86</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:45:16</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:45:17</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:45:18</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:45:19</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:54:42</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:54:43</td>
<td>0</td>
<td>224</td>
<td>1</td>
<td>NA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P3 W3 TI6B20</td>
<td>UIM</td>
<td>Do140</td>
<td>Instant Replay Status Update</td>
<td>01/15/2015 14:01:55:41</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>NA</td>
<td></td>
</tr>
</tbody>
</table>
Instant Replay from Compact Flash Files

Overview

Instant Replay log files can also be accessed via device Compact Flash files. To accomplish this, IntelliLink software can be used to gain access to and download the necessary Compact Flash files from the devices themselves. When done, the IntelliTeam Designer program can be used to extract the necessary data to display the Instant Replay event data in the Instant Replay viewer.

Using Compact Flash Files

Follow these steps to use a Compact Flash file:

STEP 1. Download the .EVT files that match the field event time frame from every participating device by using the IntelliLink Compact Flash access functionality.

STEP 2. Determine which devices participated in the field event for which the Instant Replay is being created. See Figure 114.

![Compact Flash Access Screen](image)

Figure 114. The Compact Flash Access screen.

STEP 3. Make sure there is a separate directory for each participating device that contains all available .EVT files for that device. Do not put .EVT files from different devices in the same directory, and do not put .EVT files from the same device into different directories.

STEP 4. In IntelliTeam Designer, switch to the Instant Replay mode and open the circuit that was loaded into the participating devices at the time that the field event under investigation occurred.

STEP 5. Click the Communicate to Devices button in the upper toolbar. The IntelliTeam SG Communication Manager dialog box will open. Click on the Log Files tab. See Figure 115 on page 113.
STEP 6. Use the check boxes on the left side where all of the devices are shown and select all the devices that participated in the event. Add a single device or add all devices belonging to a specified FeederNet. See Figure 116.
STEP 7. Double-click on the directory icon for each device and then search that directory for the necessary .EVT files. See Figure 117. Repeat this process until all .EVT files have been selected for all devices that were part of the event.

Figure 117. The directory search for .EVT files dialog box.

STEP 8. Use the Clock Offset configuration when the device clock is out of synchronization by a known amount of time greater than several minutes. See Figure 118.

Figure 118. The Clock Offset entry.
STEP 9. Specify the Timestamp Time Zone, Approx. Event Time, and Duration for the event under investigation. The timestamp should be set a few minutes before the actual time the event began and the duration set a number of minutes longer than the event.

When the clocks in the participating devices are not perfectly synchronized, provide more leeway when entering event time and duration. The amount of leeway depends on how unsynchronized the device clocks are.

The Do Not Filter Events (Get All) check box uses every historic event in the specified timeframe for the Instant Replay. By default, only a few core events are incorporated, and we recommend the default. See Figure 119.

![Figure 119. The Communication Manager—Instant Replay Generation Setup dialog box.](image)

STEP 10. Click on the Collect from Log button. A prompt to name and save the replay file will open. See Figure 120.

![Figure 120. The Collect from Log button.](image)

STEP 11. If no errors are encountered, the Success dialog box opens. See Figure 121. Click on the OK button, and close the Communication Manager screen.

![Figure 121. Success dialog box.](image)
IntelliTeam Designer is now populated with the Instant Replay generated from the data provided. See Figure 122.

**Figure 122. Drawing Space populated with the Instant Replay data.**

**STEP 12.** If some event data, such as switch operations, appear to be missing, open the **Communication Manager** screen and adjust the Approx. Event Time configuration. Make sure all participating devices have a proper directory with all relevant .EVT files configured.

**STEP 13.** If using controls with GPS, the control device time will be synchronized. If the clocks are not synchronized, manually adjust the timestamps:

(a) Enter **Reorder Events** mode by clicking the **Clock** button on the Instant Replay bar below the circuit one-line diagram. The **Reorder Selected** button will open next to the **Clock** button. See Figure 123 on page 117.
(b) In the Instant Replay Log below the circuit diagram, select events from different devices known to have occurred at the same time. S&C recommends checking the State Points Only check box above the Instant Replay Log. Hold the <CTRL> key to make multiple selections.

For example, if the event was an overcurrent, then all overcurrent events upstream of the faulted field are likely to have occurred at the same time. For a loss of substation source, all voltage losses on the affected FeederNet are likely to have occurred at the same time. If a switch opened, the open operation and voltage losses on downstream switches are likely to have occurred at the same time.
(c) When all events have been selected, click on the **Reorder Selected** button. The following dialog box will open. See Figure 124.

![Figure 124. Synchronize Events From Different Devices dialog box.](image)

(d) To synchronize all the other device clocks with one specific device, click to select the device to synchronize. See Figure 125 on page 119.

It isn't necessary to adjust the timestamps for multiple events. Choose just one event and modify its timestamps, thus causing the timestamps of all events coming from the selected devices to be shifted so they are synchronized.

(e) Enter the timestamp manually. That will adjust the timestamps so all events coming from the selected devices will occur at the same time.

(f) Click on the **Apply Changes** button. This dialog box will close, and the event list below the circuit diagram will display events in the order modified, based on the input with this dialog.
STEP 14. Usually one event is not shared by all controls, so repeat Step 12, starting on page 116, and alter timestamps for different groups of controls to get a correctly ordered Replay sequence.

STEP 15. When the event order appears to be correct, click on the Clock button next to the Reorder Selected button. The Reorder Selected button will disappear, and the normal Instant Replay bar buttons will return.

STEP 16. Click the Save As button to save the time-adjusted Instant Replay file for future reference.

Figure 125. Synchronize Events From Different Devices dialog box.
The Log Viewer allows easily reading and monitoring logs generated by IntelliTeam Designer in either the **SG Mode** or **DEM Mode** setting. To open the Log Viewer, go to the **Tools** menu and click on the Log Viewer entry. Log Viewer data can also be exported to an Excel file; the default delimiter is “|” (the pipe symbol). See Figure 126.

Four log types can be loaded into the Log Viewer:

- **Database Logs**—Loads logs from S&C Electric databases (Make a valid database connection to read these logs.)
- **Event Logs**—Loads logs generated by Dialog boxes Event Viewer and filters based on key words
- **DEM File Logs**—Loads the control logs generated in DEM mode
- **File Logs**—Loads any other log file (The default delimiter is the pipe symbol, but other delimiters can be used.)

![Figure 126. Log Viewer screen.](image)
Log Viewer File Menu

To add a log file, click the menu entry: File>Open and Add Log File... or to remove a log file, click on the menu entry: File>Remove Selected Log File.

The SCLogViewerSettings file has all the added and removed log files and database logs. Save the SCLogViewerSettings file in a different location that can be loaded separately. The default settings file is saved in Windows 10 as: c:\Users\<username>\AppData\Local\S&CElectric\LogViewer\SCLogViewerSettings.xml. See Figure 127.

![Figure 127. Log Viewer File menu.](image)

Database Connection

Databases are created and stored in the DEM computer, and databases for larger IntelliTeam SG systems will be stored in an Oracle database. IntelliTeam Designer can be used to view a database file. Select the Data menu and click on the Add Database Connection entry. See Figure 128.

Log on to the server and the available databases will be displayed. Click to select the database name to open, and click on the Connect button. See Figure 129 on page 122.

![Figure 128. Log Viewer Data menu.](image)
Tailing a Log

After loading a log file, tail it by clicking on the Tailing File button. See Figure 130. Tailing a file adds real-time log lines to the file. The status bar shows whether tailing is occurring. Click on the Tailing File button again to stop the Tail process.
Logging Files

For Log Viewer to open a log file, it must be saved in the .evt format. See S&C Instruction Sheet 1032-570, “Compact Flash Access: Operation,” for details on how to save a log file in the .evt format.

Filters

When a log file has been loaded into IntelliTeam Designer, the events can be filtered to group data. Select the parameter to be filtered and filter range. Then, click the Filter button: See Figure 131.

Follow these steps to use filtering:

**STEP 1.** Select a filter type from the drop down list. Line Number, Date and Time, ID, Level, Category, and Description can be filtered.

**STEP 2.** Select a filter operator from the drop-down list.

- Line Number and ID use the Between filter operator that produces a range from the starting to the end value. A starting or end value must be entered. If only the starting value is entered, the range starts at that value and continues to the end of the list. If only an end value is entered, the range starts at the beginning and ends at that value. The other filter types use the Equal or Contains filter.
- The Equal filter operator produces a data range that exactly matches the contents of the filter request and is case sensitive.
- The Contains filter operator produces a data range that includes the text of the filter request.
Figure 132 shows the normal contents of the log file.

Figure 132. Normal Log File contents; the last line number is at the end of the list.

**STEP 3.** The line number can be filtered to start at #5. See Figure 133.

Figure 133. Data filtered to start at Line Number 5.
**STEP 4.** The line number can be filtered to end at #5. See Figure 134.

![Figure 134. Data filtered to end at Line Number 5.](image)

**STEP 5.** The line number can be filtered to start a #3 and end at #5. See Figure 135.

![Figure 135. Data filtered to display from line number 3 to line number 5.](image)
STEP 6. The category can be filtered by the Equals filter operator. See Figure 136.

![Figure 136. Data filtered to display category entries equal to “Error.”](image136.png)

STEP 7. Click on the Filter button: . See Figure 131 on page 123.

**Exporting Data**

Enable export using the **Enable IntelliTeam FMS Export** button. See Figure 137.

![Figure 137. The Enable IntelliTeam FMS Export button location.](image137.png)

After a log file has been loaded into IntelliTeam Designer and the data filtered (if required), the data can be exported by clicking the **Export** button. 

The export data is produced with a | (pipe symbol) delimiter and can be imported into Excel using the | delimiter. See Figure 138.

![Figure 138. Exported text with the “|” (pipe symbol) default delimiter.](image138.png)
The IntelliTeam FMS Feeder Management System must have a complete list of the system field devices and their communication parameters to retrieve data. IntelliTeam Designer contains this information and can export device parameters to the IntelliTeam FMS application. IntelliTeam Designer can also verify the IntelliTeam FMS device list.

To export IntelliTeam Designer data, open the **Options** menu and select the **Enable FMS Export** option. See Figure 139.

Follow these steps to export IntelliTeam Designer data to the IntelliTeam FMS application:

**STEP 1.** Open the IntelliTeam Designer circuit from which data need to be exported.
**STEP 2.** Open the communication manager.
**STEP 3.** If IntelliTeam FMS communication with some of the field devices does not use the IP addresses configured in the **Device Attributes** tab of the circuit, then override the communication settings as necessary in the **Device Configuration/Status** tab.
**STEP 4.** Click on the **FMS Export** button on the Communication Manager toolbar. See Figure 140 on page 128.
**STEP 5.** The Check netlist dialog box opens. See Figure 141 on page 128. This gives the option to verify the circuit data in the field devices matches the presently loaded circuit.

---

**Exporting Data**

Follow these steps to export IntelliTeam Designer data to the IntelliTeam FMS application:

**STEP 1.** Open the IntelliTeam Designer circuit from which data need to be exported.
**STEP 2.** Open the communication manager.
**STEP 3.** If IntelliTeam FMS communication with some of the field devices does not use the IP addresses configured in the **Device Attributes** tab of the circuit, then override the communication settings as necessary in the **Device Configuration/Status** tab.
**STEP 4.** Click on the **FMS Export** button on the Communication Manager toolbar. See Figure 140 on page 128.
**STEP 5.** The Check netlist dialog box opens. See Figure 141 on page 128. This gives the option to verify the circuit data in the field devices matches the presently loaded circuit.
STEP 6. Click on the No button to skip this check. Performing the check is recommended. Click on the Yes button in the Check netlist dialog box. See Figure 141. If the netlist check is not successful, it is recommended not to proceed and confirm the correct IntelliTeam Designer circuit was opened.

STEP 7. The FMS Export Dialog screen will open. See Figure 142.
<table>
<thead>
<tr>
<th><strong>FMS Export Features</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FMS Connection</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Standard</strong></td>
<td>Specify the Host portion of the FMS url. Do not specify the protocol (i.e. “http” or “https”) or the port number (i.e. “:80”).</td>
</tr>
</tbody>
</table>
| **Custom** | In some rare cases, the IntelliTeam FMS application cannot be located using the standard method noted above.  
If that is the case, specify the Protocol, Port, and any additional path explicitly. Generally, the complete text in this field should match text typed in the browser to access the IntelliTeam FMS main Web page. |
| **HTTP Timeout** | The HTTP Timeout feature controls how long it takes for IntelliTeam Designer to time out during Export Data and Get List operations. Increase this if the system is slow, or the amount of data is very large. |
| **Data Transfer/Export Data to FMS** | The Data Transfer/Export Data to FMS feature transmits the list of devices contained in the presently loaded IntelliTeam Designer circuit and their communication parameters from IntelliTeam Designer to the IntelliTeam FMS application. If the operation is successful, the IntelliTeam FMS application will be able to talk to the devices immediately upon completion. This operation also includes configuration of the device access server (DAS).  
**Note:** A device can never be deleted from the IntelliTeam FMS software after its data have been imported.  
**Note:** Do not export circuits with duplicate device or substation names. This is not presently supported. |
| **Data Transfer/Get List of FMS Devices** | The Data Transfer/Get List of FMS Devices function retrieves the list of all devices the IntelliTeam FMS application is presently configured to use. The retrieved data also includes some key parameters:  
Connectivity Set (Designer Circuit Name), Device Type, DNP Address, and IP Address.  
This feature may be used to verify device data before or after the export operation. |
### Status

The **Status** function is the present state of the IntelliTeam FMS data transfer process. The possible states are:

- **Idle**—Appears only when the dialog is first brought up
- **In Progress**—A data transfer operation is in progress (All other IntelliTeam Designer functionality is blocked in this state until it succeeds, an error is encountered, or the operation times out.)
- **Success**—Appears when one of the two supported data transfer operations succeeds
- **Error**—Appears when the requested operation did not succeed (There are numerous possible error states.)

### Detailed Operation Data/Clear Log

The **Detailed Operation Data/Clear Log** feature clears the log of the detailed operation data.
In some cases, the **Export** operation may not complete successfully. The **Status** indication will contain the exact error code and the Detailed Operation Data Log will contain any additional descriptions. Possible error conditions are shown in Table 2.

**Table 2. Export Error Codes.**

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONNECTION_ERROR</td>
<td>IntelliTeam Designer could not connect to IntelliTeam FMS application</td>
<td>Make sure that the IntelliTeam FMS connection is set up correctly</td>
</tr>
<tr>
<td>DATA_ERROR</td>
<td>IntelliTeam FMS application did not accept the data. The log will contain additional information</td>
<td>If the error description is stated in the log, close the FMS Export Dialog box, correct the error, and try again. Otherwise, contact S&amp;C and provide the entire contents of the log</td>
</tr>
<tr>
<td>DAS_ERROR_CONNECT</td>
<td>IntelliTeam FMS application could not connect to DAS</td>
<td>Make sure that the DAS Server IP address and port parameters are set correctly on the Settings page of the IntelliTeam FMS application</td>
</tr>
<tr>
<td>DAS_ERROR</td>
<td>DAS did not accept the configuration. The log will contain additional information. When this error is encountered during the Export operation, DAS configuration is disabled, and the IntelliTeam FMS application will not be able to talk to any devices</td>
<td>If the error description is stated in the log, close the FMS Export Dialog, correct the error, and try again. Otherwise, contact S&amp;C and provide the entire contents of the log</td>
</tr>
<tr>
<td>DAS_ERROR_ROLLEDBACK</td>
<td>DAS did not accept the configuration. The log will contain additional information. When this error is encountered during the Export operation, the current DAS configuration (before the last export attempt) remains active and the IntelliTeam FMS application will continue to collect data based on that configuration</td>
<td>If the error description is stated in the log, close the FMS Export Dialog, correct the error and try again. Otherwise, contact S&amp;C and provide the entire contents of the log</td>
</tr>
<tr>
<td>BAD_FMS_FEEDBACK</td>
<td>IntelliTeam Designer received an unexpected reply from the IntelliTeam FMS application</td>
<td>Contact S&amp;C and provide the entire contents of the log</td>
</tr>
<tr>
<td>ERROR</td>
<td>An unknown error occurred</td>
<td>Make sure the IntelliTeam FMS connection parameters are correct. If so, contact S&amp;C and provide the entire contents of the log</td>
</tr>
</tbody>
</table>